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Chapter 1

Introduction

Hello, and welcome to DCP-o-matic!

1.1 What is DCP-o0-matic?

DCP-o-matic is a set of tools to allow you to:

o Create Digital Cinema Packages (DCPs) from video, audio, subtitle and closed-caption files.
o Play and verify DCPs (see Chapter 18 and Chapter 19).

o Create KDMs for DCPs (see Chapter 10).

o Write cinema-format drives containing DCPs (see Chapter 20).

e Manipulate existing DCPs in various ways (see Chapter 21 and Chapter 22).

1.2 Licence

DCP-o-matic is free and open-source and is licensed under the GNU GPL.

1.3 Acknowledgements

This manual uses icons from the Tango Desktop Project, with thanks.

1.4 This manual

This manual presents bits of DCP-o-matic’s user interface (such as menu items or buttons) like this.

% Notes of an advanced nature are presented like this. Ignore them unless you want to
know the details.



https://en.wikipedia.org/wiki/Digital_Cinema_Package
https://www.gnu.org/licenses/old-licenses/gpl-2.0.html
http://tango.freedesktop.org/
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Chapter 2

Installation

2.1 Windows

To install DCP-o-matic on Windows, download the installer from https://dcpomatic.com/ and double-click it. Click
through the installer wizard, and DCP-o-matic will be installed onto your machine.

Use the 64-bit installer unless you are using a 32-bit version of Windows. You may find that DCP-o-matic crashes if
run the 32-bit version on a CPU with more than 4 cores.

2.2 mac0S

DCP-o-matic versions 2.16.0 and higher will run on macOS version 10.8 (Mountain Lion) and higher. DCP-o-matic is
split into ten separate applications, each of which can be installed by downloading the .dmg, double-clicking to open
and then dragging the icon to your Applications folder.

If you don’t know which parts of DCP-o-matic to install, start with the first (main) part.

If you are using macOS 10.7 (Lion) or older you will need to install the latest 2.14.x version of DCP-o-matic.

2.3 Debian, Ubuntu and Mint Linux

There are .deb packages for Debian, Ubuntu and Mint on https://dcpomatic.com/

For Debian there are both x86 and ARM packages, so choose the correct one for the CPU type you are using (most
people will need x86).

2.4 Fedora, Centos and Mageia Linux
There are .rpm packages for Fedora, Centos and Mageia on https://dcpomatic.com/

For Fedora there are both x86 and ARM packages, so choose the correct one for the CPU type you are using (most
people will need x86). You can install the ARM packages on Asahi Linux on mac.

2.5 Arch Linux

Packages for Arch Linux are available from https://aur.archlinux.org/packages/dcpomatic/, thanks to Benjamin Radel
and Markus Kalb.



https://dcpomatic.com/
https://dcpomatic.com/
https://dcpomatic.com/
https://aur.archlinux.org/packages/dcpomatic/

2.6 Building from source

Since DCP-o-matic is open-source you can also build it yourself, though this can be quite a difficult process (especially
on Windows and macOS). There are instructions for how to do it on https://dcpomatic.com/building


https://dcpomatic.com/building
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Chapter 3

Creating a DCP from a video

In this chapter we will see how to create a DCP from a video file using DCP-o-matic. We will gloss over the details

and look at the basics.

3.1 Creating a new film

Let’s make a very simple DCP to see how DCP-o-matic works. First, we need some content. Download the low-
resolution trailer for the open movie Sintel from their website. Generally one would want to use the highest-resolution

material available, but for this test we will use the low-resolution version to save on download time.

Now, start DCP-o-matic and its window will open. First, we will create a new ‘film’. A ‘film’ is how DCP-o-matic
refers to some pieces of content, along with some settings, which we will make into a DCP. DCP-o-matic stores its
‘film’ data in a folder on your disk while it creates the DCP.

You can create a new film by selecting New from the File menu, as shown in Figure 3.1.

New... N Ctrl+N
Open... Ctrl+O
Save Ctrl+S

Save as template...

Duplicate...

Duplicate and open...

1 /home/carl/DCP/test

2 [home/carl/test

3 /home/carl/DCP/template

Close Ctrl+W
Quit Ctrl+Q

Figure 3.1: Creating a new film

This will open a dialogue box for the new film, as shown in Figure 3.2.



http://sintel.org/
https://download.blender.org/durian/trailer/Sintel_Trailer.480p.DivX_Plus_HD.mkv

Film name DCP Test|
Createin folder @ bcp v

From template

Y Cancel OK

Figure 3.2: Dialogue box for creating a new film

In this dialogue box you can choose a name for the film. This will be used to name the folder to store its data in, and
also as the initial name for the DCP itself. You can also choose where you want to create the film. In the example
from the figure, DCP-o-matic will create a folder called ‘DCP Test’, inside my existing folder DCP, into which it will
write its working files.

DCPs can be very large (more than 100GB for a feature-length DCP) so it’s important to choose a folder on a disk
with plenty of free space.

3.2 Adding content

The next step is to add the content. DCP-o-matic can make DCPs from multiple pieces of content, but in this example
we will use a single piece. Click the Add file(s)... button, as shown in Figure 3.3, and a file chooser will open for you
to select the content file to use, as shown in Figure 3.4.

File Edit Jobs View Tools Help
Content DCP
Add"‘kle(s)...
Add folder...

Add DCP...

Figure 3.3: Adding content files



Cancel Choose a file or files Q m

©® Recent 4 fcarl DCP manual »

1 Home

€ Sintel_Trailer.480p.DivX_Plus_HD.mkv 7.4 MB 12 Feb 2018

<, Downloads
dd Music

[ Pictures
»@ Videos

™ Camera

»

All files v

Figure 3.4: Selecting a video content file

Select your content file and click Open. In this case we are using the Sintel trailer that we downloaded earlier.

When you do this, DCP-o-matic will take a look at your file. After a short while (when the progress bar at the bottom
right of the window has finished), you can look through your content using the slider underneath the black preview
area, as shown in Figure 3.5.

Outline content Left v Jump to selected content

225

[ < > Play ——

00:00:09.08

Figure 3.5: Examining the content

Dragging the slider will move through your video. You can also click the Play button to play the content back.

3.3 Making the DCP

In most cases, some adjustments would be made to DCP-o-matic’s settings once the content has been added. For our
simple test, however, the default values are fine, so we can go straight onto making the DCP.

Choose Make DCP from the Jobs menu. Before encoding your DCP, DCP-o-matic will run a series of checks on your
film to look for things that might cause problems when playing back the DCP. If any potential problems are found,
DCP-o-matic will show you a list of hints. Each hint describes what was found and gives advice on how to resolve
it. If hints are found and reported, you can either Make DCP anyway (without adjusting any settings), or Go back in
order to make adjustments before encoding the DCP.

If no hints were found (or you pressed Make DCP after hints were displayed), DCP-o-matic will encode your DCP.
This may take some time (many hours in some cases). While the job is in progress, DCP-o-matic will update you
with the progress bar in the bottom of the window, as shown in Figure 3.6.



Transcoding test
Encoding 17%; 208/1253 frames

Figure 3.6: Making the DCP

When it has finished, the DCP will be written into its own folder inside the film’s folder. You can copy this to a
projector via a USB stick, hard-drive or network connection. See Chapter 14 for details about the files that DCP-o-
matic creates, and Chapter 20 for details of a DCP-o-matic tool which can write the DCP to an external hard-drive.

Alternatively, DCP-o-matic can upload your DCP directly to a projector or Theatre Management System (TMS) that
is accessible via SCP or FTP across your network. See Section 11.13.
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Chapter 4

Creating a DCP from a still image

DCP-o-matic can also be used to create DCPs of one or more still images, perhaps for an advertisement or an on-screen

announcement. This chapter shows you how to do it.

As with DCPs made from video files, the first step is to create a new ‘Film’; select New
new film dialogue will open as shown in Figure 4.1.

Film name DCP Test|
Createin folder @ Dcp v

From template

A Cancel OK

Figure 4.1: Dialogue box for creating a new film

Enter a name and click OK. Now we need to add the content. As before, click Add file(s)
add a single image file, as shown in Figure 4.2.

from the File menu and the

.... For our example, we will




Cancel Choose a file or files Q
© Recent 4 fcarl src  dcpomatic = doc = manual »
2 Home
q @ i i .
% Downloads dcpomatic_cli.xml 1.6 kB 15 May 2019
@ dcpomatic_create.xml 2.1kB 15 May 2019
dd Music dcpomatic-html.xsl 841bytes 6Jan2019
) © dcpomatic_kdm_cli.xml A 2.3kB 15 May 2019
3 Pictures
dcpomatic-pdf.xsl 1.5kB 6 Jan2019
'@ Videos "] diagrams 01:00
@ extensions.ent 81 bytes 01:07
M Camera a Y
@ extensions-html.ent 81 bytes 16 Jul 2017
[ dcpomatic @ extensions-pdf.ent 81 bytes Yesterday
E7 help-im-stuck.png 66.5kB 16 Jul 2017
[ Documents [ html 01:00
[ pdf 01:07
Allfiles v

Figure 4.2: Selecting a still content file

Most of the default settings will be fine for a simple test. The one thing that you might wish to change is the length
of the still. Select the Timing tab and you will see a Full length setting, as shown in Figure 4.3.

Video Timing
h @ m : s : F A

Position 0 1 : 0 10 Set
Move to start of reel

Full length 0 0 10 : 0 Set

Trim from start = 0 0 : 0 0 Set
Trim up to current position

Trim fromend 0 0 : 0 0 Set
Trim from current position to end

Play length 00:00:10:00

Figure 4.3: The timing tab

This length is a ‘timecode’: it consists of four numbers. The first is hours, the second minutes, the third seconds, and
the fourth frames. Enter the duration that you want and then click Set.



Finally, as with video, you can choose Make DCP from the Jobs menu to create your DCP. This will be much quicker
than creating a DCP from a video file, as DCP-o-matic only needs to encode a single frame which it can then repeat.
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Chapter 5

Manipulating existing DCPs

DCP-o-matic is often used to take content in formats such as MP4 and make it into a DCP. It can also be used to
take existing DCPs and modify them in various ways.

5.1 Importing a DCP into DCP-o0-matic

The first step in manipulating an existing DCP is to import it. Click Add DCP... and select your DCP’s folder. It
will be added to the DCP-o-matic project. If the DCP is unencrypted you can preview it in the normal way, though
playback may be slow as decoding of DCPs is almost as computationally intensive as encoding them.

If your DCP is a Version File (VF) (i.e. it refers to another DCP’s assets) you should import it as follows:

e Use Add DCP... to import the VF DCP. The VF DCP will be added to the content list and marked “NEEDS OV”.
¢ Right-click on the VF DCP in the content list and choose Add OV... from the menu.

e Choose the folder that contains the OV DCP. The VF will now be playable as normal.

5.2 Decrypting encrypted DCPs

DCPs can be encrypted (see Chapter 10 for details). If you import an encrypted DCP you will need a key, in the form
of a Key Delivery Message (KDM), to decrypt it.

KDMs must be prepared by whoever created the DCP. They contain the keys to decrypt the DCP wrapped up in such
a way that only the intended recipient can read them. You will need to provide the KDM creator with a certificate
which identifies your copy of DCP-o-matic and allows them to create a KDM for you.

To get DCP-o-matic’s decryption certificate, open the Preferences dialogue (see Chapter 11) and go to the Keys tab.
Click the Export KDM decryption leaf certificate... button at the top of this tab and save the certificate. Send this
certificate to the KDM creators and they can make a KDM to allow DCP-o-matic to decrypt the DCP.

Once you have your KDM, right-click the DCP’s name in the DCP-o-matic content list and choose Add KDM.... Select
your KDM and the DCP will be decrypted and become available for preview.

5.3 Making a DCP from a DCP

In many ways, using DCPs as content in DCP-o-matic is the same as using any other content. There are a few things
to note, though.




5.3.1 Re-use of existing data

Where possible DCP-o-matic will re-use existing JPEG2000-compressed data from DCP content without modification.
This has the advantage that creation of the new DCP will be quick, as the time-consuming JPEG2000 encoding is not
necessary.

DCP-o-matic can do this if you avoid changes to the following content settings:

e Crop

e Scaling

¢ Subtitle burn-in

o Fades

e Colour conversion

DCP-o-matic will be forced to decode and re-encode your JPEG2000 data if you change any of these settings on a
piece of DCP content.

5.3.2 Making overlay files

With its default settings, DCP-o-matic will take any data from DCP content and copy it into the DCP that it creates.
See Figure 5.1.

ooment DCP New DCP.......
Picture . Make DCP Picture
—
Sound Sound
Subtitle Subtitle

Figure 5.1: Creating a new DCP by copying an existing one

This can be inefficient in some cases. Consider, for example, a film which has ten different translations for which the
subtitles are different but video and audio are the same. If the video and audio content takes up, say, 100Gb this
means that the set of DCPs for every translation would be about 1Th, with a lot of duplicated data.

The DCP format has a solution to this problem. One DCP can refer to the ‘assets’ (picture, sound or subtitle) of
another DCP. For our translation example this means that we could have a ‘base’ DCP (often called the OV or Original
Version) containing video, audio and one set of subtitles and then any number of overlay DCPs (often called VF or
Version Files) which refer to the base version and replace the original subtitles with their own. Figure 5.2 shows this
principle for one of our translations. The DCP that we make refers to the original content DCP’s video and audio
rather than containing a copy.



Content DCP _ New DCP

Refer to sound

Picture

Subtitle #2

Subtitle #1

Figure 5.2: Creating a new DCP by referring to an existing one

To play back the subtitled DCP the projectionist ingests both the base (OV) DCP and the overlay (VF) DCP, then
plays the VF one.

To make a DCP like this:

e Import your ‘Content DCP’ to a DCP-o-matic project.
o Add whatever replacement you want in your new DCP (replacement subtitles or audio files, for example).
¢ Open the Version File Setup dialogue box using the Version File (VF)... option in the Tools menu.

o Tick the relevant checkboxes for the parts of your existing DCP that you want to re-use (e.g. to refer to, or re-use,
the video from the existing DCP, tick the Video checkbox).

¢ Do Make DCP as usual and your VF DCP will be created.

The VF setup dialog is shown below, set up to refer to both picture and sound from an existing DCP:

DCP Picture Sound  Subtitles Closed captions

BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605_CPP_IOP_OV

OK

Figure 5.3: Setup for making a Version File (VF)
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Chapter 6

Content settings

The previous chapters showed DCP generation using the default settings. DCP-o-matic offers a range of features to
adjust the content that goes into your DCP, and this chapter describes those features in detail.

6.1 Adding and removing content

At the top of the Content tab is a list of the content that will go into our DCP. There can be as many pieces of content
as you like, and they can be of the following types:

e Movie — a file containing some video, probably some audio and possibly some embedded subtitles; for example, a
MOV, MP4 or VOB.

¢ Sound — a file containing one or more channels of audio; for example, a WAV or AIFF file.
o Still image — a file containing a single still image; for example, a JPEG, PNG or TIFF file.
e« Moving image — a directory containing many still images which should be treated as the frames of a video.

o Subtitle — a file containing subtitles which will be superimposed on the image of the DCP. These can be .srt, .ssa,
.ass or .xml files. Subtitle files can also be used to make closed captions.

¢ DCP — an existing DCP.

o« ATMOS MXFs — if you have Dolby ATMOS content in MXF format (created using Dolby’s tools) you can add it
to a DCP just like any other content.

To add one or more movie, sound, still-image or subtitle files, select Add file(s)... and choose them from the selector.

DCP-o-matic will automatically map a set of audio files to the correct channels if you include appropriate ‘tags’ in
your filenames, as shown in Table 6.1.

To add a directory (folder) of images, choose Add folder... and choose the directory from the selector. DCP-o-matic
will open a small dialogue box where you can enter the frame rate that the image sequence should be run at.

To add a DCP, choose Add DCP... and choose the DCP’s directory from the selector.

You can remove a piece of content by clicking on its name and then clicking the Remove button.




Tag Examples Channel

film-L.
L surrounded by . _ or - 1 .wav . Left
my_movie_L_final.wav

film-R. .
R surrounded by . _ or - L .wav . Right
my_movie_R_final.wav

film-C.
C surrounded by . _ or - L .Wav . Centre
my_movie_C_final.wav

film-Lfe.
Lfe surrounded by . _ or - tonmhte.wav. LFE (sub)
my_movie_Lfe_final.wav

film-Ls.
Ls surrounded by . _ or - L S wav . Left surround
my_movie_Ls_final.wav

film-Rs. .
Rs surrounded by . _ or - L S wav . Right surround
my_movie_Rs_final.wav

Table 6.1: Audio file naming

6.2 Adding existing DCPs

Adding existing DCPs to a DCP-o-matic film is a little different to adding other types of content. Most content has to
be converted to JPEG2000 (the compression scheme used by DCPs) which is a very time-consuming process. Existing
DCPs are already in JPEG2000 format so do not require conversion. This means that, provided no settings such as
crop are used on the DCP content, picture and sound data will be passed from existing to new DCP unaltered.

Encrypted DCPs that are added as content will require a KDM targeted at DCP-o-matic so that DCP-o-matic can
decrypt them. You should ask the creator of the imported DCP to provide a KDM for DCP-o-matic’s decryption
certificate, which can be obtained by clicking Export DCP decryption certificate... from the Keys tab of the Preferences
dialog (see Section 11.11).

6.3 Content properties

Below the content list are the controls to set content properties. To adjust the properties for a piece of content, click
its name in the content list. The content property controls will then become active for that piece of content.

If you want to change the properties for multiple pieces of content at the same time, select the content in the list
by clicking the first piece then clicking the other pieces with shift key held down. Note that not all settings can be
changed in this way.

The content properties are split up into four sections: Video, Audio, Timed text and Timing. Not all of these sections
will be active for all content types. The controls in each section are described below.

6.4 Video

The Video tab controls properties of the image, as shown in Figure 6.1.



Video Audio Timed text Timing

Type 2D v
Left 0
8
Right 0
Crop
Top 0
8
Bottom 0
Fadein 0 .0 .0 0
Fadeout 0 0 00 00
© tofit DCP
Scale
custom dit
Colour Rec. 601 v

Range Video (MPEG, 16-235) v

Content video is 720x576, pixel aspect ratio 1.42:1

Display aspect ratio 1.78:1

Scaled to 1920x1080 (1.78:1)

Padded with black to fit container DCI Flat (1998x1080) (1.85:1)
Content frame rate 25.0000

Content and DCP have the same rate.

Figure 6.1: Video settings tab

6.4.1 Image type

The next option on this tab is the ‘type’ of the video. This specifies how DCP-o-matic should interpret the video’s
image. 2D is the default; this just takes the video image as a standard 2D frame. The 3D left/right option tells
DCP-o-matic to interpret the frame as a left-right pair, as shown in Figure 6.2.

width
Left Right
eye : eye
image image

width / 2

Figure 6.2: 3D left/right image type

Alternatively the 3D top/bottom option tells DCP-o-matic to see the frame as a top-bottom pair, as shown in Figure 6.3.



Left
eye
image

......................................... height

Right
helght / 2 eye
image

Figure 6.3: 3D top/bottom image type

Another option is 3D alternate which takes the first frame of the content as for the left eye, the second for the right
eye, the third for the left, and so on. Finally, you can specify 3D left only or 3D right only if this content contains only
the the left or right eye images. This is useful when you have the left and right eye image sets in different files; you
can specify one content as 3D left only and another as 3D right only and DCP-o-matic will pick up the appropriate
frames from each.

6.4.2 Colour conversion

The Colour conversion setting specifies what colour transforms and gamma correction DCP-o-matic will use when
converting the selected content into the XYZ colourspace for the DCP.

In particular, the setting you choose here should be the colour space that the content has been created or graded for.
DCP-o-matic will take care of converting your content’s colourspace into the correct one for the DCP.

The easiest way to select the required conversion is to choose one of DCP-o-matic’s presets. DCP-o-matic knows how
to convert from seven common colourspaces: SRGB, Rec. 601, Rec. 709, Rec. 1886, Rec. 2020, S-Gamut3 and P3. If
you do not know which preset you should use, refer to the suggestions in Table 6.2.

sRGB Still images in RGB, e.g. photographs.

Rec. 601 Standard-definition content (fewer than about 1000 pixels across) including DVD rips.
Rec. 709 High-definition content including Blu-Ray rips.

P3 Content explicitly graded to P3.

Table 6.2: Suggested colour conversion settings

For other required colour conversions, and if you know what you are doing, you can choose Custom which will open
the full colour conversion editing dialogue box:



¥ Use preset =~ Rec.709 v

Input gamma correction

Input transfer function Simple gamma v
Input gamma 2.20
Input power 0.100000 threshold A B

YUV to RGB conversion

YUV to RGB matrix Rec.709 =
RGB to XYZ conversion N
X y Matrix
Red chromaticity 0.640000 0.330000 0.4123908 03575843 0.1804808
0.2126390 0.7151687 0.0721923
Green chromaticity 0.300000 0.600000 0.0193308 0.1191948 0.9505322
Blue chromaticity 0.150000 0.060000
White point 0.312700 0.329000
White point adjustment
Adjust white point to 1.0000000 0.0000000 0.0000000
0.0000000 1.0000000 0.0000000
0.0000000 0.0000000 1.0000000
Output gamma correction
¥ Inverse 2.6 gamma correction on output
Cancel OK

Figure 6.4: Dialogue box for custom colour conversion

Alternatively, choose None if your source files are already in the XYZ colour space and require no conversion.

DCP-o-matic’s colour conversion processes are discussed in much more detail in a separate document colour.pdf.

6.4.3 Other settings

The crop settings can be used to crop your content, which is often used to remove black borders from the edges of
the image. The specified number of pixels will be trimmed from each edge, and the content image in the right of the
window will be updated to show the effect of the crop.

The fade in and fade out settings can be used to apply linear fades into and out of a piece of content. Specify the time
for each, clicking Set after making any changes.

The Scale option governs the shape that DCP-o-matic will scale the content’s image into. In most cases to fit DCP
will do the right thing; if not, choose custom and you can specify exactly how the image should be scaled.

6.4.4 Video description

At the bottom of the video tab is a short description of what will happen to your video with the current settings. In
the example of Figure 6.1, DCP-o-matic is telling you that the video file is 720x576 pixels and has rectangular pixels (a


https://dcpomatic.com/manual/colour.pdf

pixel aspect ratio of 1.42:1) and so its display aspect ratio is 1.78:1. Since the controls specify to fit DCP DCP-o-matic
scales the image to 1918x1080 and pads it to the DCP’s container ratio of 1.85:1 (called ‘DCI Flat’). For a 2K DCP
this is 1998x1080 pixels.

This description also gives the frame rate of the content and what will happen to it when it is played at the DCP’s
frame rate. See Chapter 12 for details of DCP-o-matic’s frame-rate conversion.

6.5 Audio
The Audio tab controls properties of the sound, as shown in Figure 6.5.

Video Audio Timed text Timing
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Figure 6.5: Audio settings tab

6.5.1 The audio map

The section at the bottom of the audio tab is the ‘audio map’ This governs how sound from the content will be
arranged in the DCP.

Down the left-hand side of the map is the list of audio channels in the currently-selected piece of content. These are
labelled with two numbers; the first is the stream index within the content and the second is the channel number within
that stream. Some content will have different streams for different languages or audio mixes. Along the top is each

channel in the DCP. A green box means that the corresponding content channel will be copied into the corresponding
DCP channel.

When content channels are copied into DCP channels the copy can be done with variable gain. If, for example, you
want to copy a channel as-is, you can set a gain of 0dB. Alternatively, if you want to mix two channels into one, you
may want to use a gain of -6dB on each one to prevent clipping when the two channels are added.

The green boxes of the audio mapping view tell you (very roughly) how much gain is applied to each channel. A
full-height box means 0dB (i.e. unity) gain. Any less height indicates lower gain.



To map one channel to another with 0dB gain, click in the empty box and it will turn green to reflect the mapping.
A second click will turn the mapping back off. To set some other gain, right-click on the box to open the gain menu.
This allows you to set Off (no mapping or negative infinity gain), Full (0dB gain), -6dB gain or Edit which allows you

to set the required gain precisely.

Consider, for example, the case in Figure 6.6.
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Figure 6.6: Audio map example 1

Here, we have two channels in the source which are mapped to left and right, respectively, in the DCP. The full green
boxes show that the mapping is at unity gain (0dB) in each case. Imagine that we modify the settings to those shown

in Figure 6.7
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Figure 6.7: Audio map example 2

We now have the content’s streams mapped to left and right and also mixed together and placed in the DCP’s centre
channel. The smaller green boxes on the centre mappings show that those channels are added with some non-unity
gain; you can see by hovering the mouse pointer over those boxes that the gain for content channels 1 and 2 is -6dB
when being sent to the centre channel and 0dB when being sent to left and right.
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Figure 6.8: Audio map example 3

As a final example, the map in Figure 6.8 shows the mapping of a 5.1 source into a 5.1 DCP.



6.5.2 Other controls

Show graphs of audio levels will analyse the audio of the selected content and plot it on a graph. See Section 7.2 for
more details.

Gain is used to alter the volume of the soundtrack. The specified gain (in dB) will be applied to each sound channel
of your content before it is written to the DCP.

If you use a sound processor that DCP-o-matic knows about, it can help you calculate changes in gain that you should
apply. Say, for example, that you make a test DCP and find that you have to run it at volume 5 instead of volume 7
to get a good sound level in the screen. If this is the case, click the Calculate... button next to the audio gain entry,
and the dialogue box in Figure 6.9 will open.

Sound processor Dolby CP650 or CP750
I want to play this back at fader

But | have to use fader

Cancel OK

Figure 6.9: Calculating audio gain

For our example, put 5 in the first box and 7 in the second and click OK. DCP-o-matic will calculate the audio gain
that it should apply to make this happen. Then you can re-make the DCP (this will be reasonably fast, as the video
data will already have been done) and it should play back at the correct volume with 7 on your sound-rack fader.

Audio Delay is used to adjust the synchronisation between audio and video. A positive delay will move the audio later
with respect to the video, and a negative delay will move it earlier.

Fade in and Fade out can be used to set fades for the audio. If your selected content also contains video you can tick
Use same fades as video if you want the audio to fade in/out with the picture. When Use same fades... is ticked the
fades used will be the ones set in the Video tab.

6.6 Timed text (subtitles and closed captions)

The timed text tab contains settings related to subtitles and closed captions in your content, as shown in Figure 6.10.



Video Audio Timed text Timing

Useas| opensubtitles v

Burn subtitlesinto image

Show subtitle area

Offset X 0 %

Y O %
Scale X 100 %

Y 100 %
Line spacing = 100 %
Language Edit... Main v
Stream eng v

Appearance...

Figure 6.10: Timed text settings tab

Depending on where timed text comes from it can sometimes be used as either an open subtitle (to be overlaid onto
the cinema screen and seen by everybody) or as a closed caption (to be displayed to individual viewers using a special
system such as the Doremi CaptiView™)

DCP-o-matic can either:

o Extract timed text that is embedded in video files, or

o Use timed text from SubRip (.srt), SubStation Alpha (.ssa or .ass) or DCP XML files. You may find the free
program Subtitle Edit useful for creating such files.

Embedded timed text is usually represented using a set of bitmaps, especially on files that have come from DVD or
BluRay. Such text can be used as a subtitle, but not a closed caption (since the closed captioning system requires the
text to be delivered as character codes rather than as an image).

In contrast, SubRip, SubStation Alpha or DCP text can be used as either a subtitle or a closed caption.

With subtitles you have the further choice of whether to burn the subtitles into the image or include them as a
separate subtitle ‘asset’ within your DCP (in which case the projector overlays them onto the image on playback).
The difference between burn-in and overlay is illustrated by Figure 6.11 and Figure 6.12.
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Shapes were invented
in 1954.

Video frame
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Shapes were invented ("burns in")
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Figure 6.11: Burnt-in subtitles
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Subtitle Subtitle

Subtitle is kept
separate from video
frame in DCP

Figure 6.12: Separate subtitles

The advantage of separate subtitles is that the same video content can be used for DCPs in many different languages.
This means that only a small text file needs to be changed for each target language, rather than a large video file. It
also means that the time-consuming video encoding need only be done once for the project rather than once for every
language.

Select the Use as check-box to enable the timed text in the selected content, then choose what you want to use the
text for: open subtitles or closed captions.

Select the Burn subtitles into image check-box to burn subtitles into the image; if this is not ticked the subtitles will
be included separately in the DCP to be rendered by the projector.

The X Offset and Y Offset controls move subtitles around within the image. These controls have no effect for closed
captions. The offsets are expressed as a percentage of the video frame size; 100% X offset is the entire width of the



frame, and 100% Y offset is the entire height. Hence, to move the subtitles down by half the frame height you would
use a Y offset of 50%.

The X Scale and Y Scale controls scale subtitles. These controls have no effect for closed captions. Scale values of 1
make the subtitles the same size (relative to the size of the image) as they are on the original. Values lower than 1
make them smaller, and values higher make them larger. You can stretch the subtitles in either direction by specifying
different values for X and Y scale. Subtitles from DVD and Blu Ray sources are frequently larger (relative to the
video frame) than those typically used for DCP, so it is often useful to scale such subtitles down using these controls.

The Line spacing control adjusts the line spacing of the subtitles. This only works for subtitles that did not come from
bitmaps.

The Stream control changes the subtitle stream that is used when the content has more than one.

If you are using non-image (text) subtitles or closed captions you can see the subtitle text and timings by clicking the
View... button, or specify the fonts that should be used by clicking Fonts....

With any subtitles you can click Appearance... to change how the subtitles look. Some of the controls in the Appearance
only apply to burnt-in subtitles, as only limited control is available for subtitles rendered by the projection system.

6.7 Timing
The timing tab contains settings related to the timing of your content, as shown in Figure 6.13.

Timing
h @ m : s : F A
Position 0 1 : 0 00

Move to start of reel

Full length 0 00 10 0
Trim from start = 0 0 : 0 0
im ur (o ition
Trim fromend 0 0 : 0 0
Im I 1 CUI t position nd
Play length 00:00:10:00

Figure 6.13: Timing settings tab

Most of the timing tab’s entries are time-codes. These are expressed as four numbers, as shown in Figure 6.14.
hours minutes seconds frames
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Figure 6.14: Timecode



Position is the time at which this piece of content should start within the DCP. In most cases, this will be 0:0:0:0 to
make the content start at the beginning of the DCP.

Full length is the length of the piece of content. This can only be set for still-image content: for video or sound content,
it is fixed by the nature of the content file. If still-image content is being used you can set the length for which it
should be displayed using this control.

Trim from start specifies the amount that should be trimmed from the start of the content. You can set this amount
to trim up to the current preview position by clicking Trim up to current position.

Trim from end specifies the amount that should be trimmed from the end of the content. You can set this amount to
trim after the current preview position by clicking Trim after to current position.

Play length indicates how long this piece of content will be once the trims have been applied. This will be equal to the
full length minus trim-from-start and minus trim-from-end.

Each timecode control has a Set which you should click when you have entered a new value for a timecode. The Set
button will make DCP-o-matic take account of any changes to the corresponding timecode.

6.8 Timeline

The timeline window gives an overview of all the pieces of content in your film, and how they are arranged. You can
open the timeline by clicking the Timeline... button next to the content list. This will open a window like the one in
Figure 6.15.
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Figure 6.15: Timeline

The horizontal axis represents time, and you can see the time codes (in hours:minutes:seconds) along the bottom of
the window. Pieces of content are represented with rectangles in the main part of the window. Content containing
different types of data (e.g. a MP4 file with video, audio and subtitles) have a rectangle for each type.

Within the timeline you can select content by clicking, and drag it to change its position. Right-clicking a piece of
content will open the content menu.

The toolbar at the top of the window offers the following tools:

e Select — to select and move content.



e Zoom in — to drag out an area that you want to see more closely.
e Zoom out — to zoom out so that the window shows the whole film.
e Snap — when enabled, content will snap to other content when you drag it close.

e Sequence — when enabled, content will be kept in sequence, without gaps, even if some content is removed.

6.9 Video processing pipeline

This section gives a little more detail about how DCP-o-matic process video as it takes it from a source and puts it
into a DCP.
Consider, as a rather contrived example, that we have a 720 x 576 image which is letterboxed with 36 black pixels

each at the top and bottom, and the video content within the letterbox should be presented in the DCP at ratio of
2.39:1 within a 1.85:1 frame (such as might happen with a trailer). The source image is shown in Figure 6.16.

36 pixels
! .
My scope image

Figure 6.16: Example image to demonstrate video processing

DCP-o-matic runs through the following steps when preparing an image for a DCP:

e Crop

e Scale

e Place in container

First, some amount of the image can be cropped. This is almost always used to remove black borders (letterboxing
and/or pillarboxing) around images.

In our example image, we would use 36 pixels of crop from the top and bottom. This would give the new image shown

in Figure 6.17.



Figure 6.17: Example image after cropping

The next step is to scale the image. Since this content should be presented in a 2.39:1 (scope) aspect ratio inside a
1.85:1 (flat) DCP we would select custom from the Scale option in the Video tab, then choose a ratio (Set ratio and fit
to DCP container) of 2.39:1.

Next, we would choose Flat from the Container option in the DCP tab.

Given the scaling and container information, DCP-o-matic will look at the DCP’s container size, and then scale the
source image up until one or both of its dimensions (width, height or both) fits the size of the container, all the while
preserving the desired aspect ratio.

In our example here, the DCP’s container is specified as 1.85:1 (so that the DCP will play back correctly using the
projector’s ‘Flat’ preset). At 2K, 1.85:1 is 1998 pixels by 1080. Scaling the source up whilst preserving its 1.85:1
aspect ratio will result in the image hitting the sides of the container first, at a size of 1998x836. This gives us a new
version of the image as shown in Figure 6.18.

My scope image
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Figure 6.18: Example image after cropping and scaling

The final step is to place the image into the DCP. In this case, since we have a 2.39:1 image that should be presented as
a 1.85:1 DCP, we have set the container in the DCP tab to be Scope. Since the content has been scaled to 1998 x 836,
and a Flat container is 1998 x 1080, there will be some black bars at the top and bottom of the image. DCP-o-matic
shares out this black equally, as shown in Figure 6.18.



My scope image

Figure 6.19: Example image in the DCP

6.10 Copy and paste settings

Once you have set up a piece of content it is possible to copy the settings you have applied to another piece of content.
To do this, select the content to copy from and choose Copy from the Edit menu. Then select the content to copy to
and choose Paste. A dialogue box will open to allow you to choose which settings you want to copy. Clicking OK will
apply the copied settings.

6.11 Advanced content settings

There are a few more content settings that you can change by right-clicking a piece of content in the list and choosing
Advanced settings... This opens the dialogue box shown in Figure 6.20.

Video filters A None Edit...

Override detected video frame rate 25

Video has burnt-in subtitles in the language

Ignore this content's video and use only audio, subtitles and closed captions

Cancel OK

Figure 6.20: Advanced content dialogue

6.11.1 Video filters

The Video filters setting allows you to apply various filters to the image. These may be useful to try to improve
poor-quality sources like DVDs. You can set up the filters by clicking the Edit button next to the filters entry; this
opens the filters selector as shown in Figure 6.21.



De-interlacing
Motion compensating deinterlacer
Kernel deinterlacer
Yet Another Deinterlacing Filter
Bob Weaver Deinterlacing Filter
Weave filter

Misc
Gradient debander D
Unsharp mask and Gaussian blur
Telecine filter

Noise reduction

High quality 3D denoiser

Orientation

Vertical flip

Horizontal flip

Rotate 90 degrees clockwise
Rotate 90 degrees anti-clockwise

OK

Figure 6.21: Filters selector

6.11.2 Override frame rate

The Override detected video frame rate setting has some different effects depending on the type of content you use it
on.

For video content, it sets the frame rate that DCP-o-matic will run the video at. This is useful if DCP-o-matic has
mis-detected the video frame rate. For example, if DCP-o-matic says your content is 24fps when you know for a fact
it’s 25fps, you can set the override value to 25 to force DCP-o-matic to do the right thing.

On audio, subtitle and caption content this setting behaves slightly differently. It sets the video frame rate that the
content in question was intended to work with. As an example, consider a project with a 23.976fps video source
and some separate audio files. Perhaps those audio files have been mastered alongside a 24fps version of your video.
By default, DCP-o-matic will see the 23.976fps video file and decide to run it slightly fast at 24fps to fit the DCP
standard. It will then also run the audio slightly fast so that it stays in sync with the video.

In this case, though, that is not what you want, since the audio is already ‘fixed’ to work alongside 24fps video. If you
override the video frame rate of the audio content to 24fps this will stop DCP-o-matic altering it.

A similar situation can occur if you have video at one rate and a subtitle file that was prepared with its timing at
a different rate. In that case, you should override the video frame rate of the subtitle content to the one that it was
prepared for. This will mean that DCP-o-matic can get the relative timing right.

Do not use this setting to change the DCP frame rate. Doing so will result in strange effects and sync problems.

6.11.3 Video has burnt-in subtitles

Details about subtitle language are stored in various places within the DCP metadata. If a piece of video content
already has subtitles burnt into the image you can tell DCP-o-matic the language that they are in by clicking the
Edit... button.



6.11.4 Ignore this content’s video

Tick this if you have some content which includes video along with other things (such as audio or subtitles) and you
do not want the video to appear in the DCP.
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Chapter 7

DCP settings

This chapter describes the settings that apply to the whole DCP. The controls for these settings are in the DCP tab
of the main window, as shown in Figure 7.1.

Content DCP

Name | mydcp|

2 Use ISDCF name Copy asname

MyDcp_FTR-1-25_F-178_XX... 1_2K_20241127_SMPTE_OV

Content Type Feature v
Encrypted

Standard SMPTE v
Markers... Metadata... Reels...

Video Audio

Container DCIFlat  ~ @ 1998x1080
Resolution 2K ~
Frame Rate 25 v

3D

Video bitrate

for newly-encoded data 200 Mbit/s

Re-encode JPEG2000 data from input

Figure 7.1: DCP settings tab

The first thing here is the name. This is generally set to the title of the film that is being encoded. If Use ISDCF name
is not ticked, the name that you specify will be used as-is for the name of the DCP. If Use ISDCF name is ticked, the
name that you enter will be used as part of a ISDCF-compliant name.

Underneath the Use ISDCF name checkbox is a preview of the name that the DCP will get. The ISDCF name will be
composed using details of your content’s soundtrack, the current date and other things that can be specified in the

Metadata dialogue box, which you can open by clicking on the Metadata button.




If you want to take the ISDCF-compliant name that DCP-o-matic generates and modify it, click Copy as name and
the ISDCF name will be copied into the Name box. You can then edit it as you wish. The DCP name should not
matter (in that it should not affect how the DCP ingests or plays) but projectionists will appreciate it if you use the
standard naming scheme as it makes it easier to identify details of the content.

The Content Type option can be ‘feature’, ‘trailer’ or whatever; select the required type from the drop-down list. On
some projection systems this will affect where your content appears in the projector’s server user interface, so take
care to select an appropriate type.

The Encrypted check-box will set whether the DCP should be encrypted or not. If this is ticked, the DCP will require
a KDM to play back. Encryption is discussed in Chapter 10.

If you use encryption DCP-o-matic will generate a random encryption key for you. To specify your own key, click the
Edit.. button next to the key.

The Reels... button opens a dialogue box which can be used to specify how the DCP will be split up into ‘reels’. See
Section 7.1.

The Standard option specifies which of the two DCP standards DCP-o-matic should use. If in doubt, use SMPTE (the
more modern of the two).

The Markers button opens the Markers dialogue, as shown in Figure 7.2.

First frame of ratings band
Last frame of ratings band
First frame of title credits
Last frame of title credits
First frame of intermission
Last frame of intermission
First frame of end credits
Last frame of end credits
First frame of moving credits

Last frame of moving credits

Close

Figure 7.2: Markers dialogue

This dialogue allows you to specify times for when certain things happen within your DCP. These times may be read
by projection systems to automate actions such as setting house light levels.

The Metadata button opens the Metadata dialogue, which allows you to specify various information about the DCP
that you are making. Some of these data will be included in the DCP’s files, and others used to make up the ISDCF
name for the DCP (if that option is being used).

At the bottom of the DCP tab are a further two tabs, one each to contain the settings for the DCP’s video and audio
parts.

The Container option sets the ratio of the image in the DCP. If this ratio is different to the ratio used for any content,
DCP-o-matic will pad the content with black. In simple cases this should be set to the same ratio as that for the the
primary piece of video content. Alternatively, you might want to pillarbox a small format into a Flat container: in
this case, select the small format for the content’s ratio and ‘Flat’ for the DCP.
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The Resolution control allows you to choose the resolution for your DCP. Use 2K unless you have content that is of
high enough resolution to be worth presenting in 4K.

The Frame Rate control sets the frame rate of your DCP. This can be a little tricky to get right. Ideally, you want it
to be the same as the video content that you are using. If it is not the same, DCP-o-matic must resort to some tricks
to alter your content to fit the specified frame rate. Frame rates are discussed in more detail in Chapter 12.

The 3D button will set your DCP to 3D mode if it is checked. A 3D DCP will then be created, and any 2D content
will be made 3D compatible by repeating the same frame for both left and right eyes. A 3D DCP can be played back
on many 3D systems (e.g. Dolby 3D, Real-D etc.) but not on a 2D system.

The JPEG2000 bandwidth for newly-encoded data; setting changes how big the final image files used within the DCP
will be. Larger numbers will give better quality, but correspondingly larger DCPs. The bandwidth can be between 50
and 250 megabits per second (Mbit/s). Most commercial DCPs use bit rates between 75 and 125 Mbit/s.

Re-encode JPEG2000 data from input governs whether or not JPEG2000-encoded data from a piece of content (usually
a DCP) will be re-used in the output data as-is or whether it will be decoded and re-encoded by DCP-o-matic. If the
option is enabled DCP-o-matic will decompress any JPEG2000 data it finds and re-encode it. This is useful if you
want to reduce the bitrate of a DCP. Usually you will achieve better quality and quicker results by leaving this option
switched off.

The Channels control sets the number of audio channels that the DCP will have. If the DCP has any channels for
which there is no content audio they will be replaced by silence. You can only set an even number of channels here,
since that is required by the DCI standard. If you want an odd number of channels, set the DCP channel count to
one greater than you need and the unused channel will be filled with silence.

The Processor control allows you to select a process to apply to the audio before it goes into the DCP. One process is
currently provided:

o Mid-side decoder — this will take a L/R stereo input and extract the common part (corresponding to the ‘Mid’ in
a mid-side signal) into the DCP’s centre channel. The remaining L /R parts will be kept in the L/R channels of the
DCP. This may be useful to make near-field L./R mixes more compatible with cinema audio systems.

If there is spoken language in your project’s audio you can tick the Language checkbox and then specify the language
of that audio. This information will be used for the ISDCF name, written into the DCP cover sheet, and added as
metadata to the audio MXF files in the DCP.

7.1 Reels

A ‘reel’ in a DCP is a subsection of the DCP, in the same way as a 35mm reel is a section of a film. A DCP can be
split up into any number of reels and the joins (the equivalent to 35mm splices or changeovers) between the reels are
seamless.

There is no reason why you can’t just use a single reel for the whole of your DCP, as there is no limit to their length.
Many people choose to do this.

There are, however, some possible advantages of splitting things up into reels:

e The picture, sound and subtitle data of the DCP will be split up into more smaller files on disk, rather than fewer
larger files. This can be useful if the DCP is to be transferred on storage that has a file size limit. The FAT32
filesystem, for example, can only hold files smaller than 4Gb. A 6Gb DCP with a single reel could not be transferred
using a FAT32-formatted disk. If that DCP were split up into two 3Gb reels it could be transferred.

o It is easier to re-use DCP components if they are in reels. Consider, for example, a film company who wants to
put a 5 second ident onto the beginning of DCPs that they distribute. If they receive a feature film DCP they
can modify it to add their ident as a separate reel. This is easier than attaching the picture data to the feature’s
existing data.



To change how your DCP will be split up into reels, click the Reels... button in the DCP tab to open the reels dialogue:

Reel mode Custom v

Maximum reel size | 2 GB

Snap when dragging

#1 F #2 P #3 |
r T

Reel1toreel2 0 0 24 23 Set

Reel2toreel3 0 1 032 13 Set

Close

Figure 7.3: Editing reels

The Reel mode control lets you choose different ways that the reel breaks are decided. As you change the mode, the
timeline below is updated to reflect the new setting.

Single reel simply uses one reel for the entire DCP. This is fine in most cases: select it if you are unsure.

Split by video content puts a reel break at the start and end of each piece of video content. This is useful if you want to
make it easier, for example, to make VF which swaps out some credits or an introduction ident. If you have a project
like the one below, for example:

Reel {» Reel 2 Reel §

=

ident.md feature.ts |cred.mok

Figure 7.4: Making reels using split by video content

you can more easily make a VF with a different ident if the ident is in its own reel.

Split by maximum reel size is useful if you want to limit how large the video file for each reel is. With this option
selected you can alter Maximum reel size as required. The video files for the reels in the DCP are not guaranteed to
be exactly your requested size, but they should be close.

Custom allows you to put your reel breaks wherever you like. In this mode you can right-click on the timeline and
choose Add reel boundary from the menu. Once you have reel boundaries you can drag them around, or set their
timecodes precisely with the controls under the timeline. You can also remove a reel boundary by right-clicking it and
choosing Remove reel boundary. Ticking Snap when dragging means that the reel markers will snap to the reel markers
of existing DCPs in your project, or the start position of any other content.



7.2 Show audio

The Show Audio button will instruct DCP-o-matic to examine the audio in your content and plot a graph of its level
over time. This can be useful for getting a rough idea of how loud the sound will be in the cinema auditorium. A
typical plot is shown in Figure 7.5

Cursor: none

Channels
® Left
@ Centre
-10dB @ Lfe (sub)
® Left surround
@ Right surround
-20dB
Type
-30dB Peak
RMS
-40dB
Smoothing
-50dB
-60dB
-70dB
00:00:20 00:00:40 00:01:00 00:01:20 00:01:40 00:0
Sample peak is -6.25dB at 00:01:12.23 on C
True peak is -6.25dB
Integrated loudness -27.11 LUFS
Loudness range 16.17 LU
LEQ(m) 76.02dB
Close

Figure 7.5: Audio plot

The plot gives the audio level (vertical axis, in dB) with time (horizontal axis). 0dB represents full scale, so if there
is anything near this you are in danger of clipping the projector’s audio outputs.

There are two plot types: the peak level and the RMS, which can be shown or hidden using the check-boxes on the
right hand side of the window.

The channel check-boxes will show or hide the plot(s) for the corresponding channels in the DCP.

The smoothing slider applies a variable degree of temporal smoothing to the plots, which can make them easier to
read in some cases.

Underneath the plot are shown some precise numbers for peaks and other measurements. A peak value displayed in
red means that it is greater than -3dB.

The audio plot is no substitute for listening in an cinema, but it can be useful to get levels in roughly the right area.
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Chapter 8

Templates

If you frequently make DCPs with similar settings you may find it useful to use templates.

Say, for example, you often make 4K feature DCPs from video files in scope at 25fps. You can speed up this process
by following these steps:

o Create a film with any content and set it up how you like; in our example, set the content to scale to DCP, the
DCP resolution to 4K, and so on.

¢ Choose Save as template... from the File menu.

¢ Click Save as new new with name to make a new template.

e Enter a name for your template.

Then in the future you can create a new film, tick the Template box and choose your previously-saved template. The

basic film’s settings will come from your template, and when you add some content it will take on the settings of the
first similarly-typed piece of content in your template.

For example, if the template has a piece of video content and some subtitles, any video that you add to the new film
will take on the settings of the video in the template. Similarly, any subtitles that you add will take on the settings
of the subtitles from the template.

The following settings from the DCP tab are saved in templates:

e “Use ISDCF name” checkbox
o Content type (FTR, TLR etc.)
o Container

¢ Resolution

e JPEG200 bandwidth

e Video frame rate

¢ Encrypted checkbox

e Audio channels

o Standard (Interop / SMPTE)
e Audio processor

o Reel type and length




In addition, the settings (but not the filenames) of any content in the template are stored, as discussed above. The
status of the Keep video and subtitles in sequence checkbox from the timeline is also preserved.

There are some other options when saving a template. Save as default saves the current project as the default template
applied to all new films. If there is some setting you always use, you can add it to the default template to save time.

By choosing Save over existing template you can also update a template you made previously.
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Chapter 9

Export

As well as creating DCPs from the content you specify, DCP-o-matic can also export projects to ProRes and MP4
files. This is most often useful to convert DCPs to a file that is smaller and easier to play back.

To convert a DCP to ProRes or MP4, the first step is start a new project and import the DCP (see Chapter 5). Then,
choose Export... from the Jobs menu to open the export dialogue, as shown in Figure 9.1.

Format ProRes v

Mix audio down to stereo
Write reels into separate files
[N Write each audio channel to its own stream

23

Outputfile | Test_FTR-1-25_F-178_XX-XX_51_2K_20210507_IOP_Q

Cancel

Figure 9.1: Export dialogue

From this dialogue you can select the required output format, output file and, in the case of MP4, the quality of the
output file (by setting the CRF value).

The useful range of CRF values is from 17 (high quality but large file size) to 28 (smaller file size and still reasonable
quality).

The time needed to export, and the resulting size, depend partly on the DCP resolution set in the project. To change
that, see Chapter 7.

You can also choose whether to mix down multichannel sources to stereo and whether you want to write separate reels
to separate files.



https://trac.ffmpeg.org/wiki/Encode/H.264#crf
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Chapter 10

Encryption

DCP’s do not have to be encrypted, but they can be. This chapter discusses the basic principles of DCP encryption,
and how DCP-o-matic can create encrypted DCPs and KDMs for them.

10.1 Basics

DCPs can be encrypted. This means that the picture and sound data are encoded in such a way that only cinemas
‘approved’ by the DCP’s creators can read them. In particular, this means copies of the DCP can be distributed by
insecure means: if a bad person called Mallory obtains a hard drive containing an encrypted DCP, there is no way
that he can play it. Only those cinemas who receive a correct key delivery message (KDM) can play the DCP.

10.1.1 How it works

This section attempts to summarise how DCP encryption works. You can skip it if you like. You may need some
knowledge of encryption methods to understand it.

We suppose that we are trying to send a DCP to Alice’s cinema without a third party called Mallory being able to
watch it himself.

There are two main families of encryption techniques. The first, symmetric-key encryption, allows us to encode some
data using some numeric key. After encoding, no-one can decode the data unless they know the key.

The first step in encrypting a DCP is to encode its data with a random key using symmetric-key encryption. The
encrypted DCP can then be sent anywhere, safe in the knowledge that even if Mallory got hold of a copy, he could
not decrypt it.

Alice, however, needs to know the key so she can play the DCP in her cinema. A simple approach might be for us to
send Alice the key. However, if Mallory can intercept the DCP, he might also be able to intercept our communication
of the key to Alice. Furthermore, if Alice happened to know Mallory, he could just send her a copy of the key.

The clever bit in the process requires the use of public-key encryption. With this technique we can encrypt a block of
data using some ‘public’ key. That data can then only be decrypted using a corresponding private key which is different
to the public key. The private and public keys form a pair which are related mathematically, but it is extremely hard
(or rather, virtually impossible) to derive the private key from the public key.

Public-key encryption allows us to distribute the DCP’s key to Alice securely. The manufacturer of Alice’s projector
generates a public and private key. They hide the private key inside the projector where no-one can read it. They
then make the public key available to anyone who is interested.

DCP-o-matic has a similar arrangement except that it stores its private keys in the user’s configuration file. See
Section 5.2 for details of how to share DCP-o-matic’s certificate so that others can make encrypted DCPs for DCP-o-
matic.




We take our DCP’s symmetric key and encrypt it using the public key of Alice’s projector. We send the result to
Alice over email (using a format called a Key Delivery Message, or KDM). Her projector then decrypts our message
using its private key, giving the symmetric key which can decrypt the DCP.

If is fine if Mallory intercepts our email to Alice, since the only key which can decrypt the message is the private key
buried inside Alice’s projector. The projector manufacturer is very careful that no-one ever finds out what this key is.
Our DCP is secure: only Alice can play it back, since only her projector knows the key (even Alice does not).

10.2 Encryption using DCP-o-matic

There are two steps to distributing an encrypted DCP. First, the DCP’s data must be encrypted, and secondly KDMs
must be generated for those cinemas that are allowed to play the DCP.

The first part is simple: ticking the Encrypted box in the DCP tab will instruct DCP-o-matic to encrypt the DCP that
it makes using a random key that DCP-o-matic generates. The key will be written to the film’s metadata file, which
should be kept secure.

A DCP that is generated with the Encrypted box ticked will not play on any projector as-is (it will be marked as
‘locked’, or whatever the projector manufacturer’s term is).

The second stage of distribution is to generate KDMs for the cinemas that you wish to allow to play your DCP. There
are two approaches to this within DCP-o-matic: using the project, or using a DKDM. These approaches are now
described in turn.

10.2.1 Creating KDMs from a DCP-o-matic project

You can create KDMs from inside a DCP-o-matic project using the Make KDMs option on the Jobs menu. This will
open the KDM dialogue box, as shown in Figure 10.1.

Screens Timing
Q From 21/07/2020 v 0 : 48 until  28/07/2020 v 0 : 48
¥ My Great Cinema Add Cinema... cpL
Screen 1
2@l My Other Great Cinema Edit Cinema... CPL Browse...
Screen1 i
Remove Cinema DCP directory
Add Screen... CPLID

CPL annotation text
Output

KDM type Modified Transitional 1 v Advanced...
Folder / ZIP name format = KDM %f %c

Filename format KDM %f %c %s
e.g. KDMBambiLumiéreScreen_1.xml
1Y %b from date/time
%c cinema
%e to date/time
%f film name
%s screen
v Write to carl v
®) Write all KDMs to the same folder
Write a folder for each cinema's KDMs
Write a ZIP file for each cinema's KDMs

Send by email

Figure 10.1: KDM dialog

In order to generate KDMs for a particular projector, you need to know its certificate. These are usually made available
by the projector manufacturers as text files with a .pem extension.



DCP-o-matic can store these certificates along with details of their cinemas and screens within those cinemas. Each
screen has a certificate for its projector (and optionally certificates for other trusted devices, such as the sound
processor). DCP-o-matic can generate KDMs for any screens that it knows about.

To add a cinema, click Add Cinema.... This opens a dialogue box into which you can enter the cinema’s name, and
optionally an email address. This email address can be used to get DCP-o-matic to deliver KDMs via email. You can
also enter the time zone of the cinema, which helps to create KDMs with the correct local time windows.

Once you have added a cinema, select it by clicking on its name, then click Add Screen.... The resulting dialogue allows
you to enter a name for the screen and load in its certificate from a file. The certificate should be in SHA256 PEM
format.

Alternatively, certificates for projection systems made by some manufacturers can be downloaded from databases
provided by the manufacturer. Currently this is supported for Doremi, Dolby, Barco, Christie and GDC equipment
(through downloading Barco, Christie or GDC certificates requires you to have an appropriate account, and you need
to enter the user name and password into the appropriate tab in Download certificate. If you are targeting a screen
with equipment by one of these manufacturers you can click Download then enter the serial number of the server in
the screen and click Download again and, all being well, the certificate will be fetched. Most cinema projection or
technical departments will know these serial numbers.

Note that the reliability of the manufacturers’ certificate databases cannot be guaranteed. It is vital that KDMs are
tested by the destination cinema will in advance of show time to identify any problems.

Each KDM is made for a single Composition Play List (CPL). This is the name for a file (part of every DCP) which
lists the things that make up a single ‘composition’. A CPL might, for example, list a video file, an audio file, and
some subtitles, and give details of frames rate and other metadata. A CPL is the thing you choose to play on a cinema
projector, and is commonly a single film, a single advert, or perhaps a trailer.

A CPL is often effectively the same as a DCP, though it is possible for a single DCP (‘package’) to contain multiple
CPLs. For example, a DCP might contain CPLs that each describe the same feature film but with audio tracks in
different languages.

Once you have set up all the screens that you need KDMs for, select the CPL that you want to create the KDM for.
You can use the drop-down list to select the CPLs in the current film project, or load a CPL from somewhere else.
Select the cinemas and/or screens that you want KDMs for and fill in the start and end dates and times.

You must also select the type of KDM that you want to generate. If in doubt, use Modified Transitional 1.

@ The differences between the three KDM types are fairly subtle. DCI Specific and DCI Any
add a <ContentAuthenticator> tag to the KDM which allows the exhibitor to check that the
DCP and KDM have come from a trusted source. In addition, DCI Specific adds information
on trusted devices to the KDM. This allows the KDM creator to specify devices (such as sound
processors) that are allowed to use keys delivered by the KDM. At present it is not clear how
widely the DCI Specific and DCI Any features are supported (or even tolerated) by servers so
you are advised to use Modified Transitional 1.

Finally, choose what you want to do with the KDMs. They can be written to disk, to a location that you can specify by
clicking Browse. Alternatively, if you choose Send by email the KDMs will be zipped up and emailed to the appropriate
cinema email addresses. Click Make KDMs to generate the KDMs.

10.2.2 Creating KDMs using a DKDM

It can be inconvenient to need a whole DCP-o-matic project just to create KDMs for its film. Perhaps you want
to archive the project to save space, or create KDMs on a different machine. In such situations it is easier to use
a DKDM. This is a normal KDM, but instead of being targeted at a projection system (to allow it to decrypt the
content) it is targeted at a particular user’s certificate. This means that the certificate owner can create new KDMs
for other users. The DKDM holds everything that is required to create further KDMs.



Sometimes it is useful to create DKDMs that can be used by DCP-o-matic. If you create such a DKDM you can keep
it and then, at any point in the future, use DCP-o-matic’s standalone KDM creator to make KDMs for the DKDM'’s
film for any cinema.

In other cases a DKDM is sent to a third party so that they can create KDMs for your films. This can be useful if, for
example, you have a distributor who provides 24-hour KDM support to cinemas and can create KDMs for anybody
that requires them at short notice.

To create a DKDM for DCP-o-matic, open your encrypted project and select Make DKDM for DCP-o-matic... from the
Jobs menu. Select the CPL that you want to make the DKDM for and click OK. This DKDM will then be available
in the KDM creator. This is a separate program which you can start from the same place that you start the ‘normal’
DCP-o-matic. Its window is shown in Figure 10.2.

File Edit Help
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Send by email

Figure 10.2: The KDM creator

To create KDMs, select the cinema(s) and/or screens that you want KDMs to be created for, the date range, the DCP
that the KDMs are for and the destination for the KDMs and click Create KDMs.

By default the DKDM list will list any DCPs for which you have clicked Make DKDM for DCP-o-matic in the main DCP-
o-matic program. If you have other DKDMs you can add them by clicking Add... and specifying the file containing
the DKDM.

If another organisation wants to send you a DKDM they will ask you for a target certificate. You can get DCP-o-matic’s
target certificate by opening Preferences and clicking Export DCP decryption certificate... in the Keys tab.

10.2.3 Creating KDMs for a distributor

Sometimes you have an encrypted DCP and you want to allow somebody else (for example, a distributor) to make
KDMs for the DCP on your behalf.

The normal way to do this is to send the distributor a KDM which they can use with their own KDM creation system.
Such a KDM is often called a DKDM (the ‘D’ stands for Distribution). It is the same as a normal KDM except that
it is made to work with another computer, rather than with a projection system.



To make a DKDM for a distributor you will first need to ask them to send you a decryption certificate. This should
be a small file, usually with the extension .pem.

Once you have the certificate, you will need to add a ‘fake’ cinema and screen to the list in DCP-o-matic. This is
because making a KDM for another computer uses the same process internally as making one for a projection system,
it’s just that DCP-o-matic does not have a nice way to present that.

In either the KDM window in the main DCP-o-matic, or the KDM creator, first add a new cinema by clicking Add
Cinema..., giving it a name (perhaps the name of the distributor).

Then select this new cinema and click Add Screen... to open the screen dialogue box, as shown in Figure 10.3.
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Other trusted devices
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Cancel

Figure 10.3: Adding a screen

Here you can give any name (perhaps just ‘DKDM’). Then click Get from file... and choose the certificate file that the
distributor gave you. Finally, click OK.

Now you can create a KDM for this screen, and send it to the distributor. Using that KDM the distributor can then
make KDMs for your DCP for anybody (and also, of course, decrypt the DCP if they wanted to).

10.3 Encryption keys

You should be careful when using encryption not to lose important keys.

If you are making KDMs from a DCP-o-matic film you must ensure that you have a backup of the metadata.xml file
from the project, as well as the DCP itself.

If you are using a DKDM you must ensure that you have a backup of DCP-o-matic’s config.xml file, since it contains
the only key which can decrypt the DKDM. The config.xml file location depends on your operating system; possible
locations are listed in Chapter 24.

10.4 Should | encrypt?

The question of whether encryption is appropriate for a given project is a tricky one.

On the one hand, if you distribute an unencrypted DCP it is easy for anybody to take it and do whatever they want
with its contents. They could use DCP-o-matic to convert it to a MP4, show it in their cinema, or even edit and
redistribute it in ways that you do not like.



Encryption prevents this, but brings its own problems. It will be impossible for a cinema to screen your DCP unless
they have the correct KDM. This is easy enough if things work as they should, but problems can occur. For example,
cinemas may substitute broken playout servers with new ones without telling you: then the KDM that you sent them
will be invalid, and a new one required. If the cinema can’t get in touch with you, or somebody else who can create a
new KDM, they can’t screen your DCP. Often these problems are only discovered very close to showtime, with little
time for fixes.

If you are distributing encrypted DCPs widely it is worth thinking about who will make the KDMs, and who will
provide quick-response technical support. It may be a good idea to engage a company who can provide such services.

10.5 Encryption overview
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Figure 10.4: Overview of encryption



DCP-o-matic users’ manual

45 / 89

Chapter 11

Preferences

DCP-o-matic provides preferences which can be used to modify its behaviour. They are described in this chapter.

Preferences can be edited by choosing Preferences... from the Edit menu. This opens a dialogue which is split into

tabs.

11.1 General

The general tab is shown in Figure 11.1.

General Sound Defaults Servers

Set language

(restart DCP-o-matic to see language changes)

Number of threads DCP-o-matic should use

Number of threads DCP-o-matic Encode Server should use
Configuration file

Cinema and screen database file

Default "add file" location

Write relative content paths

Keys T™MS Email KDM Email

config.xml

cinemas.sqlite3

Same place as last time v

Find integrated loudness, true peak and loudness range when analysing audio

Automatically analyse content audio
Check for updates on startup

Figure 11.1: General preferences

11.2 Language

Notifications

Export...

>

If you tick the Set Language checkbox and choose a language from the list, that language will be used for DCP-o-matic.
You will need to restart DCP-o-matic to see the new language.




The translations for DCP-o-matic have been contributed by helpful users, and some are incomplete. If your language
is not on the last, or there are missing or incorrect translations, visit the DCP-o-matic website to find out how to
contribute a translation.

11.3 Number of threads DCP-o-matic should use

When DCP-o-matic is encoding DCPs it can use multiple parallel threads to speed things up. Set this value to the
number of threads DCP-o-matic should use. This should normally be the number of processors (or processor cores)
in your machine. DCP-o-matic will try to set this up correctly when you run it for the first time.

11.4 Number of threads DCP-o0-matic encode server should use

This is the number of threads that the encode server should use when it is running and helping another copy of
DCP-o-matic to speed up its encode.

11.5 Configuration file

This is the location of DCP-o-matic’s configuration file on disk. You can use this to share configuration between
several copies of DCP-o-matic: across a network share, for instance.

11.6 Cinema and screen database file

This option allows you to change the file that DCP-o-matic uses to store details of the cinemas and screens used to
make KDMs. Since DCP-o-matic 2.18.0 this is an sqlite3 file rather than XML

11.7 Default “add file” location

This option sets the ‘starting point’ for the file picker when adding content to a project. It can either be wherever you
last looked for content, or always in the same place as the DCP-o-matic project folder.

11.7.1 Write relative content paths

If this checkbox is unticked, the full filenames of content files will be stored in the DCP-o-matic project. This means
that if you move your project around, the content files will still be found. This is useful if your content files are stored
in their own place, unrelated to where you make your DCP-o-matic projects.

Ticking this box means that content filenames will be written relative to the DCP-o-matic project. This means that
you can move your project and content files to a different place and your content will still be found. This is useful if
you keep DCP-o-matic projects alongside the content they use.

11.7.2 Integrated loudness

If Find integrated loudness, true peak and loudness range when analysing audio is ticked, DCP-o-matic will do extra work
when analysing audio. Leave this ticked if the extra parameters are useful to you. If not, untick it to make audio
analysis faster.


https://dcpomatic.com/i18n.php

11.7.3 Automatically analyse content audio

If this checkbox is ticked an audio analysis will be run whenever content is added that contains sound.

11.7.4 Updates

The Check for updates on startup option, if enabled, will tell DCP-o-matic to check on dcpomatic.com to see if there
are any newer versions of DCP-o-matic then the one you are running. If so, a dialogue box will open with a link to
download the new version.

The Check for testing updates as well as stable ones option will also check for test updates as well as those that are
formally ‘released’.

11.8 Sound
The sound tab is shown in Figure 11.2.
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Figure 11.2: Sound preferences


https://dcpomatic.com/

11.8.1 Play sound via

The checkbox to the left of Play sound enables or disables DCP-o-matic’s use of sound. On some machines there will
be multiple options in the drop-down menu to decide how the sound should be played.

The mapping matrix below specifies how audio from DCP channels will be routed to your sound hardware. By default,
DCP-o-matic will mix 5.1 audio down to stereo if your chosen output device only has 2 channels.

11.9 Defaults

The defaults tab is shown in Figure 11.3.

< General Sound Defaults Servers Keys ™S Email KDM Email Notifications >
Default duration of stillimages | 10 s
Default directory for new films 3 Documents v
Default audio delay 0 ms

Default audio language Ed

Default KDM directory 3 Documents ~
Default KDM type Modified Transitional 1 v
Default KDM duration 1 weeks v

Use ISDCF name by default

Figure 11.3: Defaults preferences

The options in this tab simply allow you to set up default values for various things in DCP-o-matic.

Another way to set up defaults, especially for project settings, is to use a default template (see Chapter 8).

11.10 Servers

The servers tab is shown in Figure 11.4.

4 General Sound Defaults Servers Keys TMS Email KDM Email Notifications »

v Search network for servers

192.168.3.56 Add...
192.168.5.100
Edit...

Remove

Figure 11.4: Servers preferences



If Use all servers is ticked DCP-o-matic will locate encoding servers automatically (see Chapter 13).

Instead of this (or in addition) servers can be specified explicitly. To add a server, click Add... and enter the host
name or [P address of the server to use.

11.11 Keys

The Keys tab (shown in Figure 11.5) has controls related to the keys and certificates used in some parts of DCP
creation.

< General Sound Defaults Servers Keys ™S Email KDM Email Notifications >

Decrypting KDMs
Export KDM decryption leaf certificate...
Export all KDM decryption settings...
Import all KDM decryption settings...
Advanced...

Signing DCPs and KDMs
Advanced...

Re-make certificates and key...

Figure 11.5: Keys preferences

Export KDM decryption certificate... allows you to save the certificate that DCP-o-matic uses when decrypting KDMs
that you give it. Use this option if somebody wants to make a KDM for you and asks for your certificate.

Export all KDM decryption settings... exports a file which contains all the DCP-o-matic settings related to the use of
KDMs supplied by other people. Use this button and Import all KDM decryption settings... to transfer settings between
different copies of DCP-o-matic so that they can both use the same KDMs.

The Re-make certificates and key... button under Signing DCPs and KDMs can be clicked to recreate the signing keys
used by DCP-o-matic.

The two Advanced... buttons open advanced dialogue boxes for detailed manipulation of DCP-o-matic’s certificate
chains.

11.12 Advanced keys settings

At the top of the Advanced dialogue for signing DCPs and KDMs is the chain of certificates that will be used to sign
DCPs and KDMs. DCP-o-matic creates a random chain when you first run it and if you are happy to use this chain
you can ignore the preferences. Otherwise, you can add or remove certificates from the chain using the Add... and
Remove buttons.

If you want DCP-o-matic to re-create the certificate chain (using new, random certificates) click Re-make certificates
and key... and specify your organisation and common names in the dialogue box that opens.

Underneath the certificate chain is the private key that corresponds to the leaf certificate in the chain. You can specify
your own private key by clicking Import.... You must do this if you change the leaf certificate, so that the leaf private
key corresponds to the public key held in the leaf certificate.



At the top of the Advanced dialogue for decrypting DCPs is the chain and key which is used by DCP-o-matic when
you import an encrypted DCP as a piece of content. The leaf certificate of this chain contains the public key that
should be used when targeting a KDM at DCP-o-matic.

Clicking Export chain... will export the whole certificate chain.

11.13 TMS

The TMS tab (shown in Figure 11.6) gives some options for specifying details about your theatre management system
(TMS). If you do this, and your TMS accepts SSH or FTP connections, you can upload DCPs directly from DCP-o-
matic to the TMS using the Send DCP to TMS option in the Jobs menu.

< General Sound Defaults Servers Keys T™MS Email KDM Email Notifications >

Upload DCP to TMS after creation

Protocol SCP (For AAM and Doremi) v
IP address 192.168.1.100

Target path

User name tech

Password tech Show

Figure 11.6: TMS preferences

Protocol should be set to SCP or FTP as appropriate for your TMS. We know that the Arts Alliance Media (AAM)
and the Doremi ranges uses SCP connections, and that Dolby’s TMS uses FTP. Do let us know if you use any other
type of TMS with the Send DCP to TMS feature.

Passive mode can be ticked to enable the FTP PASV mode, if you are using FTP.

TMS IP address should be set to the IP address of your TMS, TMS target path to the place that DCPs should be
uploaded to (which will be relative to the home directory of the SSH or FTP user). Finally, the user name and
password are the credentials required to log into the TMS via SSH or FTP.

Note that for this to work on Doremi servers you will need to set the PasswordAuthentication option in your server’s
sshd_config to yes.

11.14 Email

The Email tab is shown in Figure 11.7.



< General Sound Defaults Servers Keys T™MS Email KDM Email Notifications >

Outgoing mail server | smtp.example.com port protocol = Auto v
User name carl
Password opensesame Show

Send test email...

Figure 11.7: Email preferences

These settings are used when DCP-o-matic sends emails.

Outgoing mail server should be the host name of a mail (SMTP) server that DCP-o-matic can use. You can also specify
the port. User name and Password are the credentials that are required to send email through the server you have
specified.

Clicking Send test email... opens a dialogue box where you can send a test email (using the server you have configured)
to make sure that the settings are correct.

11.15 KDM email

The KDM email tab is shown in Figure 11.8.



< General Sound Defaults Servers Keys T™MS Email KDM Email Notifications >

Subject KDM delivery: $CPL_NAME]
From address
Address Add...

CC addresses

BCC address

Dear Projectionist
Please find attached KDMs for SCPL_NAME.

Cinema: SCINEMA_NAME
Screen(s): $SCREENS

The KDMs are valid from $SSTART_TIME until SEND_TIME.

Best regards,
DCP-o-matic

Reset to default subject and text

Close

Figure 11.8: KDM email preferences

This is a template for the email that is used to send KDMs out to cinemas. You can change it to say whatever you
like. A few ‘magic’ strings will be replaced by information from the KDM that is being sent; these strings are shown
in Table 11.1.

$CPL_NAME DCP title

$CPL_FILENAME Filename of the CPL

$CINEMA_NAME Cinema name

$CINEMA_SHORT_NAME First 14 characters of the cinema name

$SCREENS Name of screen or screens that KDMs are being
generated for

$START_TIME The time from which the KDMs are valid

$END_TIME The time until which the KDMs are valid

Table 11.1: ‘Magic’ KDM strings

The Reset to default text will replace the current KDM email with DCP-o-matic’s default.



11.16 Notifications

The Notifications tab is shown in Figure 11.9.

< General Sound Defaults Servers Keys T™MS Email KDM Email Notifications >

Message box
Email

Subject DCP-o-mftic notification

From address proj@cinema.com

To address bill@cinema.com

Address Add...
CCaddresses
BCCaddress

$JOB_NAME: $JOB_STATUS

Reset to default subject and text

Close

Figure 11.9: Notifications preferences

DCP-o-matic can notify the user when jobs have completed. These notifications can be either or both of a message
box on-screen (if Message box is ticked) and email (if Email is ticked). If you enable email notifications you can fill in
the details of the emails you want to send.

The bottom box in the tab is the content of the email that should be sent. DCP-o-matic will replace the ‘magic’
strings $JOB_NAME and $JOB_STATUS in the with the details of the job that has completed.

11.17 Cover sheet

The DCP cover sheet configuration is shown in Figure 11.10.



4 ] DM catio Cover Sheet ifi nce >
$CPL_NAME

Type: STYPE

Format: SCONTAINER

Audio: SAUDIO

Audio Language: SAUDIO_LANGUAGE
Subtitle Language: SSUBTITLE_LANGUAGE
Length: SLENGTH

Size: $SSIZE

Reset to default text

Figure 11.10: DCP cover sheet preferences

This is a template for the cover sheet that is written next to every DCP that DCP-o-matic creates. You can change
it to say whatever you like. A few ‘magic’ strings will be replaced by information from the DCP that has been made:

$CPL_NAME DCP title

$TYPE DCP content type (e.g. feature, trailer...)
$CONTAINER The container ratio (e.g. flat, scope...)
$AUDIO Details of the audio channels
$AUDIO_LANGUAGE Audio language

$SUBTITLE_LANGUAGE Subtitle language

$LENGTH DCP length in hours, minutes and seconds
$SIZE DCP size in gigabytes

Table 11.2: ‘Magic’ cover sheet strings

The Reset to default text will replace the current cover sheet with DCP-o-matic’s default.

11.18 Identifiers

The Identifiers tab is shown in Figure 11.11.



< TMS Email KDM Email Notifications Cover Sheet Identifiers Non-standard Advanced >
Issuer
Creator
Company name
Product name
Product version

JPEG2000 comment

Figure 11.11: Identifiers preferences

These are a set of ‘labels’ that are written to DCPs made by DCP-o-matic and which identify the creator and product
used. If they are left blank, DCP-o-matic will use its own values which show that DCP-o-matic was used. You can use
these labels to ‘brand’ DCPs with your own company details (though these label values are not usually very prominent
on the user interfaces of projection systems).

11.19 Non-standard

The non-standard preferences are shown in Figure 11.12.

< T™MS Email KDM Email Notifications Cover Sheet Identifiers Non-standard Advanced >
Maximum JPEG2000 bit rate 250 Mbit/s
Maximum MPEG2 bit rate 50 Mbit/s

Allow any DCP frame rate

Allow full-frame and non-standard container ratios
Allow creation of DCPs with 96kHz audio

Allow mappingto all audio channels

Allow use of SMPTE Bv2.0

ISDCF name part length 14

Figure 11.12: Non-standard preferences

This tab contains preferences which enable DCP-o-matic to make DCPs with properties that are non-standard or
unusual. Think carefully before changing these preferences, as DCP-o-matic may then make DCPs which do not play
correctly on some projection systems.

Maximum JPEG2000 bandwidth specifies the maximum bit-rate of JPEG2000 that DCP-o-matic will allow you to
create. You are advised to leave this at 250Mbit/s in normal use for maximum DCP compatibility.

Maximum MPEG2 bit rate is the equivalent for MPEG2 DCPs; I am not aware of a specified maximum for MPEG2
DCPs.



Allow any DCP frame rate removes the limits on the DCP video frame rates that DCP-o-matic will create. This may
be useful for experimentation. Again, you are strongly advised to leave this unticked for normal use.

Ticking Allow full-frame and non-standard container ratios allows containers other than ‘Flat’ (1.85:1) and ‘Scope’
(2.39:1).

Ticking Allow creation of DCPs with 96kHz audio enables 96kHz as an audio sampling rate option. This is theoretically
supported by the DCP standards but rarely used in practice.

Allow mapping to all audio channels will include in the audio mappings some channels which are usually silent (8, 9 and
15).

Allow use of SMPTE Bv2.0 adds an option to disable the use of MCASubDescriptor tags for audio.

ISDCF name part length sets how long the film name can be in the ISDCF name. 14 is the recommended maximum,
but longer names should not (in theory) case problems.

11.20 Advanced

The advanced preferences are shown in Figure 11.13.

< T™MS Email KDM Email Notifications Cover Sheet Identifiers Non-standard Advanced

Video display mode Simple (safer) ~
(restart DCP-o-matic to change display mode)
Show experimental audio processors

Only servers encode

Maximum number of frames to store per thread 3

DCP metadata filename format %t
e.g. cpl_eb1c112c-ca3c-4ae6-9263-c6714fF
05d64.xml
%t type (cpl/pkl)
DCP asset filename format %t
e.g.j2c_eb1c112c-ca3c-4ae6-9263-c6714fF
05d64.mxf
%c content filename %n number of reels
%r reel number %t type (j2¢/pcm/sub)
Log General Warnings
Errors Timing
Debug: 3D Debug: encode
Debug: email sending Debug: video view
Debug: player Debug: audio analysis

Figure 11.13: Advanced preferences

Show experimental audio processors adds some extra audio processors whose quality has not been fully checked. If you
try them out it’s advisable to listen to the results in a cinema or good 5.1 listening environment to check that they
give you what you want.

Only servers encode makes DCP-o-matic encode JPEG2000 data only on encoding servers and not on the host. We
suggest you leave this unticked unless you have a good reason to do otherwise.



Maximum number of frames to store per thread sets how many frames will be queued up in memory when they cannot
yet be written to disk. Changing this value will make DCP-o-matic use more memory, but may make it more efficient
when you have a lot of CPU cores or network encoding servers.

With the filename format fields you can adjust the filenames that are used for metadata (CPL and PKL files) and
assets (MXF and subtitle files). Below each field there is a list of the ‘magic’ values that you can use in the format
and an example of a filename that you might see with your current settings.

The checkboxes labelled Log control what sort of messages DCP-o-matic writes to its log file when creating a DCP. It
is useful to leave General, Warnings and Errors ticked as this makes the log files useful for tracking down bugs.

The Timing checkbox will enable extra log entries to allow developers to investigate and optimise the speed of DCP-
o-matic. It will significantly increase the size of the log files that are generated, so in normal use it is best to leave
this unticked.
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Chapter 12

Frame rates

In an ideal world, a DCP would be created using content at the same video frame and audio sampling rates as the
DCP. This is not, however, always possible.

12.1 DCP frame rate limitations

There are some limitations to video and audio frame rates in DCPs. This is complicated by the fact that not all
projectors will play DCPs at the same frame rates. It is possible to create a DCP which one projector will play fine,
but another (of a different type, or even just with a different software version) will refuse to play.

12.1.1 Guaranteed rates

The only rates that are guaranteed to work on all DCI projectors are 24 frames per second (fps) for video and 48kHz
for audio. If you are sending DCPs to unknown places it is wise to consider using these rates if at all possible.

12.1.2 Other often-supported rates

Many projectors now in the wild support additional video frame rates: 25, 30, 48, 50 and 60 fps.

12.1.3 Adapting content to fit the DCP rate

DCP-o-matic has a few tricks to allow you to use content that is not in one of the ‘approved’ rates.
Audio is easy: DCP-o-matic can resample to 48kHz from any source rate with minimal loss in quality.

Video rate conversion is harder. DCP-o-matic’s strategy to deal with a non-supported content rate is to run it at the
wrong speed, and to adjust the audio to keep it in sync.

Let us consider the example of a 25fps source for which you want to create a 24fps DCP. DCP-o-matic will put the
frames from the source directly into the DCP without modification, but will tell the projector to play them back at
24fps. This means that the DCP’s video will run slightly slower than the original.

If DCP-o-matic did nothing else, the result of this would be that the audio would be running at the original speed with
the video running slowly. Hence the audio would drift slowly out of sync. To avoid this, DCP-o-matic also resamples
the audio such that the projector will play it too slow by the same amount. Hence it will sound slightly different but
will remain in sync with the video.

For very low or high frame rates, DCP-o-matic can also skip or duplicate frames.




12.2 Setting up

The Frame Rate control in the DCP tab sets the video frame rate that the DCP will use. Clicking Use best sets the
rate to what DCP-o-matic thinks is the best for your content. With this button, DCP-o-matic assumes that the most
commonly-working frame rates (24, 25 and 30fps) are allowed.

After this, the Video tab for each piece of content will give a summary of what DCP-o-matic is doing with that content.

You can experiment with other non-standard frame rates by ticking the Allow any DCP frame rate in the Advanced
tab of the preferences dialogue (see the Advanced preferences). You are strongly advised to use this only on your own
equipment, and only for experimentation purposes.
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Chapter 13

Encoding servers

One way to increase the speed of DCP encoding is to use more than one machine at the same time. An instance
of DCP-o-matic can offload some of the time-consuming JPEG2000 encoding to any number of other machines on a
network. To do this, one ‘master’ machine runs DCP-o-matic, and the ‘server’ machines run a small program called
dcpomatic_server.

The master and server machines do not need to be running the same operating system, so you can mix Windows PCs,
Macs and Linux machines as you wish.

13.1 Running the servers

There are two options for the encoding server: dcpomatic_server_cli, which runs on the command line, and
dcpomatic_server, which has a simple GUI. The command line version is well-suited to headless servers, espe-
cially on Linux, and the GUI version works best on Windows and macOS where it will put an icon in the system
tray.

To run the command line version, simply enter:

dcpomatic2_server_cli

at a command prompt. If you are running the program on a machine with a multi-core processor, you can run multiple
parallel encoding threads by doing something like:

dcpomatic2_server_cli -t 4

to run 4 threads in parallel.

To run the GUI version on windows, run the ‘DCP-o-matic encode server’ from the start menu. An icon will appear
in the system tray; right-click it to open a menu from whence you can quit the server or open a window to show its
status.

If you would rather not bother installing DCP-o-matic on your server computers, the other option is to use the live-CD
image that you can download from the DCP-o-matic web site.

Either burn the image to CD, or write it to a USB stick (using something like unetbootin). Boot a PC from the CD
or USB stick and it becomes a DCP-o-matic server without touching your standard operating system install.

13.2 Setting up DCP-o-matic

DCP-o-matic periodically looks on the local network for servers. Any that it finds are given work to do during encodes.
Selecting Encoding Servers from the Tools menu brings up a window which shows that servers that DCP-o-matic has
found.



https://dcpomatic.com/
http://unetbootin.sourceforge.net/

13.3 Some notes about encode servers

DCP-o-matic does not mind if servers come and go; if a server disappears, DCP-o-matic will stop sending work to it,
and will check it every minute or so in case it has come back online.

You will probably find that using a 1Gb/s or faster network will provide a significant speed-up compared to a 100Mb/s
network.
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Chapter 14

Generated files

DCP-o-matic generates a number of files as it makes a DCP. Figure 14.1 shows the files that might be generated after
you have created a DCP for a film called ‘DCP Test’.

ﬁ DCP Test
—>D log
—>u metadata.xml

DCP-o-matic's
»ﬁ video working

files
»ﬁ analysis

— 1 info

»ﬁ DCP-TEST EN-XX_UK-U 51 2K_CSY 20130218 CSY_ OV

—> u pkl 17318961-7a15-434c-b4a3-3126784bae8d.xml
L > B cpl 7ae68dd6-8347-43f4-91ca-331341378efb.xml
—> BASSETMAP.xml

} DCP
—> B dcp_test audio.mxf

—> u dcp test video.mxf

—> B dcp_test subtitle.mxf

L u VOLINDEX. xml

Figure 14.1: Creating a new film




The DCP Test folder is the one that you specify when you select the New Film option from DCP-o-matic’s menu.
Everything is stored inside this folder.

DCP-o-matic generates some working files as it goes along. These are as follows:

e log is a list of notes that DCP-o-matic makes as it goes along. This can be useful for debugging purposes if
something goes wrong.

e metadata stores the settings that you have made for this film: things like cropping, output format and so on.
e video is where DCP-o-matic writes the DCP’s video data as it encodes it.
e analysis is used to keep the results of audio analysis runs.

e info contains details of each video frame that DCP-o-matic has written so far. This is used when an encoding
operation is interrupted and DCP-o-matic must resume it.

Following this is the DCP itself: DCP-TEST_EN-XX_UK-U_51_2K_CS8Y_20130218_CSY_0V. This contains some small
XML files, which describe the DCP, and two large MXF files, which contain the DCP’s audio and video data. It may
also contain subtitles or closed captions in either XML or MXF format. This folder (DCP-TEST_EN-XX_...) is what
you should ingest, or pass to the cinema which is showing your DCP.
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Chapter 15

Command-line tools

DCP-o-matic includes some tools which allow DCP creation and manipulation from the command line or from scripting
languages. This chapter covers the use of those tools.

There are four command-line tools in DCP-o-matic.

e dcpomatic2_create creates film directories, with the associated metadata, from a list of content files.

e dcpomatic2_cli runs the transcode process on film directories.

e dcpomatic2_kdm_cli can be used to create KDMs.

e dcpomatic2_map can collect CPLs and assets from existing DCPs and make a new DCP.

Some applications will benefit from setting up the films using the main DCP-o-matic GUI and then using dcpomatic2_cli

to do the encode. This allows, for example, setup on a relatively low-powered machine before running the encode on
a higher-powered headless server.

15.1 dcpomatic2_create

The syntax for dcpomatic2_create is:
dcpomatic2_create [OPTION] <CONTENT> [[OPTION] <CONTENT> ...]
[CONTENT] are the files or folders that you want to use in the DCP. They can be:

o ‘Movie’ files in almost any common format (e.g. MP4, MOV, MKV, etc.)

o A folder containing and image sequence in almost any common format (e.g. TIFF, DPX etc.)
e Sound files (e.g. WAV, MP3, AIFF)

e Subtitles files (e.g. .srt, DCP XML, .ssa etc.)

The options are:

e -y, ——version — show DCP-o-matic version
e -h, ——help — show this help
e -n, ——name <name> — film name

--template <name> — template name




e -e, ——encrypt — make an encrypted DCP

e -c, ——dcp-content-type <type> — FTR, SHR, TLR, TST, XSN, RTG, TSR, POL, PSA or ADV
e -f --dcp-frame-rate <rate> — set DCP video frame rate (otherwise guessed from content)

e —-container-ratio <ratio> — 119, 133, 137, 138, 166, 178, 185 or 239

e -s, —-still-length <n> — number of seconds that still content should last

e --standard <standard> — SMPTE or interop (default SMPTE)

e —--no-use-isdcf-name — do not use an ISDCF name; use the specified name unmodified

e ——config <dir> — directory containing config.xml and cinemas.xml

o ——-twok — make a 2K DCP instead of choosing a resolution based on the content

e ——fourk — make a 4K DCP instead of choosing a resolution based on the content

e -0, ——output <dir> — output directory

e ——threed — make a 3D DCP

e ——j2k-bandwidth <Mbit/s> — J2K bandwidth in Mbit/s

e —-left-eye — next piece of content is for the left eye

e —-right-eye — next piece of content is for the right eye

e --channel <channel> — next piece of content should be mapped to audio channel L, R, C, Lfe, Ls or Rs
e —-—gain — next piece of content should have the given audio gain (in dB)

e --cpl <id> — CPL ID to use from the next piece of content (which is a DCP)

e ——kdm <file> — KDM for next piece of content

For example, to setup a film using a MP4 file you might do:
dcpomatic2_create -o my_film --container-ratio 185 --content-ratio 185 -c FTR -n "My Film" Stuff.mp4
This will create a folder called my_£film which is ready for a DCP to be made by dcpomatic2_cli.

dcpomatic2_create will use any default settings that you have configured in the main DCP-o-matic preferences.

15.2 dcpomatic2_cli

The syntax for dcpomatic2_cli is:

dcpomatic2_cli [OPTION] [FILM]

e -v, ——version — show DCP-o-matic version

e -h, ——help — show this help

e —f --flags — show flags passed to C++ compiler on build

e -n, --no-progress — do not print progress to stdout

e -r, ——no-remote — do not use any remote servers

e —t, ——threads — specify number of local encoding threads (overriding configuration)

e —-j, ——json <port> — run a JSON server on the specified port



. -k,
¢ -8,
o -1,
o -d,
e -C,

--keep-going — keep running even when the job is complete

--servers <file> — specify servers to use in a text file

--list-servers — just display a list of encoding servers that DCP-o-matic is configured to use; don’t encode
--dcp-path — echo DCP’s path to stdout on successful completion (implies -n)

--config <dir> — directory containing config.xml and cinemas.xml

e ——dump — just dump a summary of the film’s settings; don’t encode

e —-no-check — don’t check project’s content files for changes before making the DCP

e ——export-format <format> — export project to a file, rather than making a DCP: specify mov or mp4

e —-—export-filename <filename> — filename to export to with --export-format

e —-hints — analyze film for hints before encoding and abort if any are found

For example, to encode a film called my_film you might do:

dcpomatic2_cli my_film

15.3 dcpomatic2_kdm_cli

The syntax for dcpomatic2_kdm_cli is:

dcpomatic2_kdm_cli [OPTION] <FILM|CPL-ID>

e -h,
. -0,
. K,
. -Z,
o -f,
.« -t,
o -d,
o -F

--help — show this help

—-—output — output file or directory

--filename-format — filename format for KDMs

--container-name-format — filename format for ZIP containers

--valid-from — valid from time (in local time zone of the cinema) (e.g. “2013-09-28 01:41:51”) or “now”
--valid-to — valid to time (in local time zone of the cinema) (e.g. “2014-09-28 01:41:517)
--valid-duration — valid duration (e.g. “1 day”, “4 hours”, “2 weeks”)

--formulation — modified-transitional-1, multiple-modified-transitional-1, dci-any or dci-specific [default

modified-transitional-1]

* b

L] —a’

--disable-forensic-marking-picture — disable forensic marking of pictures essences

--disable-forensic-marking-audio — disable forensic marking of audio essences (optionally above a given

channel, e.g 12)

e —e,
e —-Z,
° —V’
e -C,
L] _S’
L] _C’
e -T

-—email — email KDMs to cinemas

--zip — ZIP each cinema’s KDMs into its own file

--verbose — be verbose

--cinema — cinema name (when using -C) or name/email (to filter cinemas)

--screen — screen name (when using -C) or screen name (to filter screens when using -c)
--certificate — file containing projector certificate

--trusted-device — file containing a trusted device’s certificate

e —-list-cinemas — list known cinemas from the DCP-o-matic settings

e —-list-dkdm-cpls — list CPLs for which DCP-o-matic has DKDMs



15.4 dcpomatic2_map

The syntax for dcpomatic2_map is:
dcpomatic2_map [OPTION] <cpl-file|ID> [<cpl-file|ID> ...]
Each <cpl-file|ID> is either a filename or a UUID of a CPL that you want to include in the output DCP.

dcpomatic2_map will search for CPLs (when given by ID) and other required assets in directories that you specify
with the -d or ——assets-dir option.

A new DCP will be created in the directory specified by -o or ——output which contains the CPLs you specify, along
with the required assets and other ancillary files (PKL, AssetMap etc.)

By default, all the required assets will be copied into the new DCP. You can change this behaviour by passing -1
or --hard-1link to hard-link the assets (on filesystems and platforms that support this) or -s or --soft-link to
soft-link the assets.

Passing -r or --rename will rename asset files to match DCP-o-matic’s configured naming scheme.

--config <dir> can be used to specify a directory containing the DCP-o-matic configuration to use for the DCP
naming scheme, creator/issuer metadata, signer chain and so on.
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Chapter 16

Loose ends

This chapter collects a few notes on bits of DCP-o-matic that do not fit elsewhere in the manual.

16.1 Resuming encodes

If you cancel a DCP encoding run half-way through, or your computer crashes... fear not. DCP-o-matic takes care to
ensure that, in most cases, it can resume encoding from where it left off. When you re-start a DCP creation, using
the same settings are a previous run, DCP-o-matic will first check that the existing picture frames are correct, and
then resume from where it left off. The checking of existing frames does take some time, but it is much faster than
running a full re-encode.

This resumption is achieved by writing a digest (hash) to disk for every image frame that is written. On resumption,
the existing MXF file for image data is read and its contents checked against the hashes.
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Chapter 17

Common tasks

This chapter describes how to carry out some commonly-required tasks with DCP-o-matic. The full details are
elsewhere in the manual: here we just discuss different approaches to these tasks and how to carry them out.

17.1 Adding subtitles to an existing DCP

You have three options:

o Make a “Version File” (VF) DCP.
¢ Make a complete DCP with projector-added subtitles.

e Make a complete DCP with burnt-in subtitles.

Making a VF DCP is usually the best option. This will be a very small DCP which contains only the subtitles: it
refers to your existing DCP for the picture and sound. The projectionist will ingest both the existing and VF DCPs
and play back the VF. The advantages of this approach are that the VF is very quick to generate, and small in size,
making it easy to distribute. This is especially useful if you have to make VF DCPs in many different languages.

Making a complete DCP with projector-added subtitles gives you a new, single DCP which the projectionist can
ingest and play. It will be the same size as your existing DCP, and fairly quick to create. This approach relies on the
projector (or server) to create the subtitles and overlay them on the image, which mostly works well but is not 100%
reliable.

Making a complete DCP with burnt-in subtitles gives you a new, single DCP but with the subtitles rendered by
DCP-o-matic and copied into your image. This is slower to create than a DCP with projector-added subtitles as every
video frame with a subtitle must be re-encoded. The advantage of this approach is that it is less likely to go wrong,
especially if you are using unusual subtitle positioning or character sets.

17.1.1 Making a VF DCP

o Start a new DCP-o-matic film.

e Click Add DCP... and specify your existing DCP’s folder.

¢ Go to the DCP tab and choose Split by video content for Reel type.

e Open the Version File (VF) setup dialogue box using the Version File (VF)... option in the Tools menu.
o Tick the Video and Audio checkboxes next to your existing DCP’s name.

¢ Add your subtitles to the film in whatever format you have.




¢ Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from
the existing DCP.

¢ Choose Make DCP from the menu.

17.1.2 Making a complete DCP with projector-added subtitles

e Start a new DCP-o-matic film.
e Click Add DCP... and specify your existing DCP’s folder.
¢ Add your subtitles to the film in whatever format you have.

o Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from
the existing DCP. Adjust the appearance using controls in the Timed Text or Closed Captions tabs if required.

o Choose Make DCP from the menu.

17.1.3 Making a complete DCP with burnt-in subtitles

e Start a new DCP-o-matic film.

e Click Add DCP... and specify your existing DCP’s folder.

e Add your subtitles to the film in whatever format you have.

¢ Go to the Subtitle tab and tick the Burn subtitles into image checkbox.

o Check the subtitle appearance in the preview; it will be slow to respond as it is having to decompress images from
the existing DCP. Adjust the appearance using controls in the Timed Text or Closed Captions tabs if required.

e Choose Make DCP from the menu.

17.2 Adding soundtracks or subtitles in different languages

If you have a film that is to be dubbed or subtitled in several languages, the best approach with DCP-o-matic is as
follows:

o Make a DCP with the common elements (perhaps just the video, or maybe the video and sound); this is known as
the Original Version (OV).

« For each language, make a new Version File (VF) DCP which refers to the OV.

Once you have done this, you send the OV DCP to every cinema and then the appropriate VF to each cinema

depending on what language they want to play the film in. The projectionist ingests both DCPs and then plays the
VF.

The advantage of this approach is that the VF DCPs are much smaller than the OV since they only have the language-
specific parts. If you are just changing the subtitles you can often ship the OV by normal transport means (e.g. a
hard drive or download) and send the VF by email.

The full details of OV and VF files are discussed in Section 5.3.2. The steps can be summarised as follows:

e Create a new DCP-o-matic project for the OV, as normal, adding video and perhaps sound. Make the DCP.
e Create a new DCP-o-matic project for the VF.
e Use Add folder... to add your OV DCP to the project.



Open the Version File (VF) setup dialogue box using the Version File (VF)... option in the Tools menu.

Tick the Video checkbox next to your existing DCP’s name (you may need to select By video content for Reel type
in the DCP tab).

Check also the Audio checkbox if your OV has audio.

Add your language-specific audio and/or subtitles and Make DCP.
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Chapter 18

Playing DCPs

DCP-o-matic includes a DCP player, and although it requires a very high-speed CPU to play DCPs in full resolution,
it can also play DCPs at reduced resolutions with slower CPUs.

To use the player, start DCP-o-matic Player, and load a DCP using the Open option on the File menu.

If you load a VF and/or encrypted DCP you can add your OV and/or KDM using the appropriate options on the File
menu.

During playback the Performance area at the bottom right of the window will give details of how many frames are
being dropped; these are frames that were not decoded from the DCP quickly enough. If this number is high you can
increase performance at the cost of rendering quality by choosing an option from the View menu. If you set the player
to decode at less than full resolution the DCP’s data will be decoded at this lower resolution, which is quicker than
decoding at full resolution.

Another way to improve performance is to set the Video display mode in Preferences to OpenGL (faster). This should
provide a significant speed-up on most systems, although this mode has not been so widely tested so may have
problems.

18.1 Advanced playback mode

By default, the DCP-o-matic player is set up to load and play back single DCPs, mostly for checking purposes. There
is also a second, more experimental mode, which is more suited to using DCP-o-matic for ‘presentation’ applications,
such as playing back DCPs via a projector. In this mode you can set up basic playlists, in a similar way to how most
commercial playback servers work.

Using DCP-o-matic for theatrical exhibition is not widely tested, and I would not advise depending on it without plenty
of testing in your particular environment.

The ‘advanced’ playback mode uses two windows (instead of the usual one):

o Full-screen playback window.

¢ Control window.

The idea is that these windows are spread over two monitors (or one monitor and one projector).

To enable ‘advanced’ mode, load the player and go to the preferences and open the General tab of preferences, then
choose full screen with separate advanced controls from the Start player as drop-down list. Then close and re-start the
player.

On loading the player in ‘advanced’ mode you will see a control window like the one in Figure 18.1.
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00:01:04  test SMPTE_TST-B1P_S_EN-EN-CCAP_51-HI-VI_2K_ISDCF_20151123_DPPT_SMPTE [DCP]

00:02:32 trailer XMenDarkPhoenix_TLR-12-3D_F_DE-XX_DE_51_2K_TCFG_20190227_TM_IOP-3D_OV [DCP]
00:01:55  trailer XMenDarkPhoenix_TLR-22-2D_S_DE-XX_DE_51-ATMOS_2K_TCFG_20190415_TM_SMPTE_...
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00:02:03 trailer BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605_CPP_IOP_OV [DCP]

00:00:03  feature  Multi_FTR-1_F-133_XX-XX_MOS_2K_20231223_SMPTE_OV [DCP]

DCP Performance

XMenDarkPhoenix_TLR-22-2D_S_DE-XX_DE_51-ATMOS_2K_TCFG_20190415_TM_SMPTE_OV  Audio channels: 14 Dropped frames: 0
Size: 2048x858 Subtitles: no Decode resolution: 1024x429
Frame rate: 24 Length: 0:01:55.3 (2763 frames)

Figure 18.1: Player in advanced mode

The important parts are the list of playlists, in the top left, and the current playlist, on the right. Double-click a
playlist to load it, and then press the Play button to start playback.

Creating playlists must be done using the separate DCP-o-matic Playlist Editor. As with the other tools, this is
included with the normal installer on Windows and most Linux distributions, but must be downloaded separately on
macOS or if you are using Applmage.

The first important step after loading the playlist editor for the first time is to set the location of your playlists, the
content (i.e. DCPs) that they will use, and a folder containing any KDMs that the content needs. This can be done
in the Playlist Editor preferences window, as shown in Figure 18.2.

R
Locations
Content directory Examples v
Playlist directory Playlists v
KDM directory (None) v

Close

Figure 18.2: Playlist editor preferences

Once you have done this you can start creating playlists in the main editor window. Each playlist you create will be
shown in the player and so be available for playback. The playlist editor is shown in Figure 18.3.
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BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605... 7c9cac45-2420-4253-a8d6-dd36019afe21

Figure 18.3: Playlist editor

The top half of the window shows the current list of playlists. Create a new one by clicking the New button.
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can then edit its name and add remove, or reorder content in the bottom half of the window. Playlists are saved

automatically each time they are changed.
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Chapter 19

Verifying DCPs

The DCP-o-matic Player (see Chapter 18) also offers a DCP verifier. To check a DCP, open it and then select Verify
DCP from the Tools menu.

The verifier will report three kinds of problems:

e Errors — serious problems with the DCP that are likely to cause problems on playback.

It will also report some ‘good’ things, which have been checked and found to be in order.

The following sections list what the verifier checks for in each category.

Bv2.1 errors — errors described by the SMPTE Bv2.1 standard.

Warnings — small problems that may not matter.

19.1 Errors

A general error when reading the DCP.

The hash of the CPL in the PKL does not agree with the CPL file.
The hash of a main picture asset agrees with the PKL file.

The hash of a main picture asset does not agree with the PKL file.
The hash of a main picture is different in the CPL and PKL.

The hash of a main sound asset does not agree with the PKL file.
The hash of a main sound is different in the CPL and PKL.

A file mentioned in an asset map cannot be found.

The DCP contains both SMPTE and Interop-standard components.

Some XML fails to validate against its XSD/DTD.
No ASSETMAP or ASSETMAP.xml was found.
An asset’s IntrinsicDuration is less than 1 second.

An asset’s Duration is less than 1 second.

The JPEG2000 data in at least one picture frame is larger than the equivalent of 250Mbit/s.



https://ieeexplore.ieee.org/stamp/stamp.jsp?arnumber=9161348

o A subtitle lasts for longer than the reel which contains it.

e The audio bit depth must be 24.

e General error during JPEG2000 codestream verification.

e Some closed captions do not have the same vertical alignment within a <Subtitle> node.
e Some closed captions are not listed in the XML in the order of their vertical position.

e Some <MainMarkers> asset has an <EntryPoint> that should not be there.

e Some <MainMarkers> asset has an <Duration> that should not be there.

¢ A <ContentKind> has been specified with either no scope or the SMPTE 429-7 scope, but which is not one of those
allowed.

e A valid <ContentKind> was seen.

o FEither the width or height of a <MainPictureActiveArea> in a CPL is either not an even number, or bigger than
the corresponding asset dimension..

e A valid <MainPictureActiveArea> was seen.

¢ A PKL has more than one asset with the same ID.

¢ An ASSETMAP has more than one asset with the same ID.

e The sound assets in the CPL do not have the same audio channel count..

e The CPL contains a <MainSoundConfiguration> tag which does not describe the number of.
e An interop subtitle file has a <LoadFont> node which refers to a font file that is not found..
¢ A tile part in a JPEG2000 frame is too big..

o A subtitle or closed caption file has a <Font> tag which refers to a font that is not.

¢ A SMPTE subtitle asset has at least one <Text> element but no <LoadFont>.

e An ID in an asset map does not match the ID obtained from reading the actual file..

e The CPL namespace is not valid..

¢« A SMPTE CPL does not contain a <ContentVersion> tag.

19.2 Bv2.1 errors

e The frame rate given in a reel for the main picture is not 24, 25, 30, 48, 50 or 60.

e DCP is Interop, not SMPTE (Bv2.1 6.1).

o A language or territory does not conform to RFC 5646 (Bv2.1 6.2.1).

o A picture asset does not have one of the required Bv2.1 sizes (in pixels) (Bv2.1 7.1).
o A picture asset is 2K but is not at 24, 25 or 48 fps as required by Bv2.1 (Bv2.1 7.1).
o A picture asset is 4K but is not at 24fps as required by Bv2.1 (Bv2.1 7.1).
o A picture asset is 4K but is 3D which is not allowed by Bv2.1 (Bv2.1 7.1).
o A closed caption’s XML file is larger than 256KB (Bv2.1 7.2.1).

o Any timed text asset’s total files is larger than 115MB (Bv2.1 7.2.1).



The total size of all a timed text asset’s fonts is larger than 10MB (Bv2.1 7.2.1).
Some SMPTE subtitle XML has no <Language> tag (Bv2.1 7.2.2).

Not all subtitle assets specify the same <Language> tag (Bv2.1 7.2.2).

Some SMPTE subtitle XML has no <StartTime> tag (Bv2.1 7.2.3).

Some SMPTE subtitle XML has a non-zero <StartTime> tag (Bv2.1 7.2.3).

There are more than 3 closed caption lines in at least one place (Bv2.1 7.2.6).

There are more than 32 characters in at least one closed caption line (Bv2.1 7.2.6).
The audio sampling rate must be 48kHz (Bv2.1 7.3).

The CPL has no <AnnotationText> tag (Bv2.1 8.1).

At least one asset in a reel does not have the same duration as the others.

If one reel has a MainSubtitle, all must have them.

If one reel has at least one ClosedCaption, all reels must have the same number of ClosedCaptions.
MainSubtitle in reels must have <EntryPoint> (Bv2.1 8.3.2).

MainSubtitle <EntryPoint> must be zero (Bv2.1 8.3.2).

Closed caption in reels must have <EntryPoint> (Bv2.1 8.3.2).

Closed caption MainSubtitle<EntryPoint> must be zero (Bv2.1 8.3.2).

<Hash> must be present for assets in CPLs.

If ContentKind is Feature there must be a FFEC marker.

If ContentKind is Feature there must be a FEMC marker.

There must be a <CompositionMetadataAsset>.

CPL metadata should contain <VersionNumber> of 1, at least.

There must be an <ExtensionMetadata> in <CompositionMetadataAsset> (Bv2.1 8.6.3).
<ExtensionMetadata> does not have the correct form (Bv2.1 8.6.3).

A CPL containing encrypted content is not signed (Bv2.1 8.7).

A PKL containing encrypted content is not signed (Bv2.1 8.7).

If a PKL has one CPL its <ContentTitleText> must be the same as the PKL’s <AnnotationText>.
Some, but not all content, is encrypted.

Invalid number of guard bits in a 2K JPEG2000 stream (should be 1) (Bv2.1 10.2.1).
Invalid number of guard bits in a 4K JPEG2000 stream (should be 2) (Bv2.1 10.2.1).
JPEG2000 tile size is not the same as the image size (Bv2.1 10.2.1).

JPEG2000 code block width is not 32 (Bv2.1 10.2.1).

JPEG2000 code block height is not 32 (Bv2.1 10.2.1).

There must be no POC markers in a 2K codestream (Bv2.1 10.2.1).

There must be exactly one POC marker in a 4K codestream (Bv2.1 10.2.1).

A POC marker has incorrect content (Bv2.1 10.2.1).



e A POC marker was found outside the main head (Bv2.1 10.2.1).

« Invalid number of tile parts for 2K JPEG2000 stream (should be 3) (Bv2.1 10.2.1).
« Invalid number of tile parts for 4K JPEG2000 stream (should be 6) (Bv2.1 10.2.1).
e No TLM marker was found (Bv2.1 10.2.1).

e The MXF ResourceID of a timed text resource was not the same as that of the contained XML essence (Bv2.1
10.4.3).

e The AssetID of a timed text MXF is the same as its ResourceID or that of the contained XML essence (Bv2.1
10.4.2).

o The ContainerDuration of a timed text MXF is not the same as the Duration in its reel (Bv2.1 10.4.3).

e An Interop subtitle asset has no subtitles.

19.3 Warnings

e An assetmap’s <Path> entry is empty.

e The JPEG2000 data in at least one picture frame is larger than the equivalent of 230Mbit /s.
¢ An asset that the CPL requires is not in this DCP; the DCP may be a VF.

¢ A stereoscopic asset has an MXF which is marked as being monoscopic.

o The first subtitle or closed caption happens before 4s into the first reel (Bv2.1 7.2.4).

o At least one subtitle is less than the minimum of 15 frames suggested by (Bv2.1 7.2.5).

o At least one pair of subtitles are separated by less than the the minimum of 2 frames suggested by (Bv2.1 7.2.5).
e There are more than 3 subtitle lines in at least one place (Bv2.1 7.2.7).

e There are more than 52 characters in at least one subtitle line (Bv2.1 7.2.7).

e There are more than 79 characters in at least one subtitle line (Bv2.1 7.2.7).

o The <AnnotationText> is not the same as the <ContentTitleText> (Bv2.1 8.1).

e There should be a FFOC marker.

e There should be a LFOC marker.

e The FFOC marker should be 1.

e The LFOC marker should be the last frame in the reel.

e Something could not be verified because content is encrypted and no key is available.

e Some timed-text XML has an empty <Text> node.

e« A SMPTE subtitle asset as an <IssueDate> which is not of the form yyyy-mm-ddThh:mm:ss.
o A subtitle XML root node has more than one namespace (xmlns) declaration..

e The <LabelText> inside a <ContentVersion> is empty.



19.4 Notes which indicate that something is correct

e The hash of a CPL in the PKL agrees with the CPL file.

e The JPEG2000 data in all picture frames of an asset is smaller than the maximum size.
¢« A CPL has a valid release territory.

¢« A CPL has an annotation text which matches the <ContentTitleText>.

e A PKL <AnnotationText> matches a CPL <ContentTitleText>.

o All content is encrypted.

e No content is encrypted.

e A <LabelText> inside a <ContentVersion> is valid.
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Chapter 20

Writing DCPs to disks

Once you have your DCP, you need to get it to the cinema or theatre who will play it. Sometimes this is possible
via the internet, using a service such as Filemail. If that’s an option: go for it! Network transfers avoid a lot of the
difficulties that other methods have.

However, your DCP may be too large to make that practical. In that case, the usual approach is to copy the DCP
onto a USB hard drive or stick and physically take it or send it to the cinema.

20.1 Hard drive formatting

In theory, this should be as simple as dragging and dropping the DCP’s files onto a USB-connected drive. Sadly,
though, things are not always that simple. This is because not all hard drives are formatted in the same way. The
most common formats for hard drives are:

e APFS — used by macOS 10.13 and later for solid state drives (SSDs).

e HFS+ (Mac OS Extended) — used by macOS on 10.12 and earlier, and on all macOS systems for spinning disks.
¢ NTFS — modern format used by Windows.

o ExFAT — another modern, but less common (and buggier) format used by Windows.

e FAT32 — old format used by Windows.

o ext2, ext3, extd — often used by Linux.

You can format a drive however you want, but a drive set up on macOS will usually use APFS, just as one set up on
Windows will probably use NTFS or ExFAT.

The problem you have as a DCP maker is: the only format that is guaranteed to work in all cinemas is ext2. This
format is not easy to use directly from Windows or macOS: both operating systems need extra software to write ext2
drives.

The “DCP-o-matic Disk Writer” provides a possible solution to this problem. It allows you to format and copy DCPs
onto ext2-formatted disks from Windows, macOS or Linux.

20.2 Caution

DCP-o-matic is made by one developer in his spare time. As a project, we do not have any quality assurance
department, testing team or anything like that. Though we try our best to ensure quality using automated testing,
and by the great efforts of our users to find and report problems, bugs do get into the code and things do go wrong.




Though very undesirable, bugs in most parts of DCP-o-matic are usually not disastrous; they most often result in an
error message, or some problem with a DCP. The Disk Writer tool, however, is a bit different. It obtains permission
from your operating system to write directly to disks connected to the computer. Though we have done as much as
we can to prevent problems, there is a chance that a bug in the Disk Writer could cause irretrievable data loss (for
example, if the writer wrote to the wrong drive by mistake).

No such problems have been reported, nor found by us during testing, but I would like to warn you that they are
possible. As always, make sure that you have backups (somewhere that is not directly connected to your computer)
of anything that you do not want to lose.

20.3 Writing a DCP to a disk

Starting up the Disk Writer will open its main window:

Add...

DCPs

Drive v Refresh

Figure 20.1: The Disk Writer

Next, click Add... and choose the DCP that you want to write. You can write several DCPs to the same drive by
clicking Add.. again.

Now we need to choose the drive that the DCPs will be written to from the drop-down menu. Whichever drive you
choose will be irretrievably wiped! If the drive you want is not listed, click Refresh to search the system for drives.

Finally, click Copy DCPs. After a confirmation window, the drive will be formatted, and the DCPs copied and then
read back to check that they were written correctly.
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Chapter 21

Combining DCPs

The main ‘DCP-o-matic’ tool is designed to create a single DCP containing a single Composition Play List (CPL): in
other words, a single folder containing one film, trailer or advert that can be played.

However, it is also possible to have a single DCP folder containing multiple CPLs. A projectionist can then ingest
(copy) a single thing onto their playback server but have the choice of several different things to play. This is often
useful to package up different versions of a film (perhaps with different subtitles or audio tracks) into a single folder.

The difference between a single folder multiple CPLs, or multiple folders each containing a single CPL, is not great,
but sometimes a single folder is more convenient.

In an ideal world, perhaps it would be possible to create multi-CPL DCPs from the main ‘DCP-o-matic’ tool. This
is not yet possible (mostly because I find it hard to imagine a user interface that allows it without complicating the
more common ‘single CPL’ case). Instead, there is a separate tool, the ‘DCP-o-matic Combiner’ that allows multiple
DCPs to be combined into a single one.

Loading the DCP-o-matic Combiner shows a small window:

Add...

DCPs

Drive v Refresh

Figure 21.1: The Combiner

First, click Add... to add the DCPs that you want to join. Fill in an annotation text (a title) for the combined DCP.
Finally, choose an output folder, click Combine and your combined DCP will be prepared.
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Chapter 22

Editing DCP metadata

The main ‘DCP-o-matic’ tool is designed to ease creation of new DCPs from existing content. Though it re-uses data
where appropriate, it will almost always create new assets (the large files containing picture, sound or subtitles).

Sometimes it is necessary to make small edits to existing DCPs (especially to the metadata) or to fix DCPs that have
errors. DCP-o-matic has a tool for that: the ‘DCP-o-matic Editor. Though it is currently quite limited in what it
can do, you may still find it useful.

Opening the ‘DCP-o-matic Editor’ shows its window:

File Help

CPL

Open a DCP using File -> Open

Figure 22.1: The Editor

Load a DCP by using the Open... option from the File menu. This will display some details about the DCP:




File Help

BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605_CPP_IOP_OV

Annotation text BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605_CPP_IOP_OV
Issuer CPP
Creator Colorfront Transkoder 2017

Content title text = BadTimesAtEIRo_TLR-2_F_DE-XX_DE_51_2K_TCFG_20180605_CPP_IOP_OV

a85269cf-3344-4092-a33¢-c9323f264b63

Edit...

Reels

Figure 22.2: The Editor with a DCP loaded

You can make any changes you wish to the text fields, then re-create the DCP’s XML files by choosing Save from the
File menu. The DCP-o-matic Editor will fix the various checksums, as required, and re-sign the files using its own
certificate.

You can also make changes to the metadata of the individual reels by choosing a reel in the list and clicking Edit....
Reels are shown in a window like this:

Picture Sound

Annotationtext | fox_bad_times_trl_2 f 5B16AE17701D001 0.me|
Entry point 0
Duration 2969

Intrinsic duration = 2969

Figure 22.3: The Editor editing a reel
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Keyboard shortcuts

Key Action

Ctrl+A Add file(s) to the film

Ctrl+-B Make DCP in the batch converter

Ctrl+C Copy settings from currently selected content
Ctrl+D Make DKDMs

Ctrl+E Export video file

Ctrl+K Make KDMs

Ctrl+M Make DCP

Ctrl+N New film

Ctrl4+0O Open existing film

Ctrl+P Open preferences window

Ctrl+S Save current film

Ctrl4+T Open timeline window

Ctrl4+V Paste settings into currently selected content
Ctrl+W Close current film

Delete Remove selected content from film

Left arrow Move back one frame

Right arrow Move forward one frame

Shift+Ctrl+A Select all content

Space Start/stop playback

Table 23.1: Keyboard shortcuts
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Configuration files

Most of DCP-o-matic’s configuration is stored in an XML file called config.xml. This is stored in different places
depending on your operating system:

e Windows: c:\Users\your_user_name\AppData\Local\dcpomatic

e OS X: /Users/your_user_Name/Library/Preferences/com.dcpomatic/2

e Linux: ~/.config/dcpomatic2
Possible XML tags are as follows:

e <Version> — The version number of the configuration file format.

e <MasterEncodingThreads> — Number of encoding threads to use when running as master.
e <ServerEncodingThreads> — Number of encoding threads to use when running as server.
o <DefaultDirectory> (optional) — Default directory when creating a new film in the GUIL.

e <ServerPortBase> — Port number to use for frame encoding requests. ServerPortBase + 1 and ServerPortBase
+ 2 are used for querying servers. ServerPortBase + 3 is used by the batch converter to listen for job requests.

e <UseAnyServers> — 1 to broadcast to look for encoding servers to use, 0 to use only those configured.

e <Server> (optional) — IP address or hostname of an encoding server to use; you can use as many of these tags as
you like.

e <OnlyServersEncode> — 1 to set the master to do decoding of source content no JPEG2000 encoding; all encoding
is done by the encoding servers. 0 to set the master to do some encoding as well as coordinating the job.

e <TMSProtocol> — Protocol to use to copy files to a TMS; 0 to use SCP, 1 for FTP.
e <TMSPassive> — True to use PASV mode with TMS FTP connections.

e <TMSIP> — IP address of TMS.

e <TMSPath> — Path on the TMS to copy files to.

e <TMSUser> — Username to log into the TMS with.

e <TMSPassword> — Password to log into the TMS with.

e <Language> (optional) — Language to use in the GUI e.g. fr_FR.

e <DCPIssuer> — Issuer text to write into CPL files.




<DCPCreator> — Creator text to write into CPL files.

<Company> — name to write into MXF files.

<Product> — name to write into MXF files.

<Product> — version to write into MXF files.

<Comment> — to write into JPEG2000 data.

<UploadAfterMakeDCP> — 1 to upload to a TMS after making a DCP, 0 for no upload.
<DefaultStillLength> — Default length (in seconds) for still images in new films.
<DefaultAudioDelay> — Default delay to apply to audio (positive moves audio later) in milliseconds.
<DefaultAudioLanguage> — Default audio language to use for new films

<DefaultKDMDirectory> (optional) — Default directory to write KDMs to.

<MailServer> — Hostname of SMTP server to use.

<MailPort> — Port number to use on SMTP server.

<MailProtocol> — Protocol to use on SMTP server (Auto, Plain, STARTTLS or SSL)
<MailUser> — Username to use on SMTP server.

<MailPassword> — Password to use on SMTP server.

<KDMSubject> — Subject to use for KDM emails.

<KDMFrom> — From address to use for KDM emails.

<KDMCC> — CC address to use for KDM emails; you can use as many of these tags as you like.
<KDMBCC> — BCC address to use for KDM emails.

<KDMEmail> — Text of KDM email.

<NotificationSubject> — Subject to use for notification emails.

<NotificationFrom> — From address to use for notification emails.

<NotificationFrom> — To address to use for notification emails.

<NotificationCC> — CC address to use for notification emails; you can use as many of these tags as you like.
<NotificationBCC> — BCC address to use for notification emails.

<NotificationEmail> — Text of notification email.

<CheckForUpdates> — 1 to check dcpomatic.com for new versions, 0 to check only on request.
<CheckForUpdates> — 1 to check dcpomatic.com for new text versions, 0 to check only on request.

<MaximumJ2KVideoBitRate> — Maximum video bit rate (in bits per second) that can be specified in the GUI for
JPEG2000 encodes.

<MaximumMPEG2VideoBitRate> — Maximum video bit rate (in bits per second) that can be specified in the GUI
for MPEG2 encodes.

<AllowAnyDCPFrameRate> — 1 to allow users to specify any frame rate when creating DCPs, 0 to limit the GUI
to standard rates.

<AllowAnyContainer> — 1 to allow users to user any container ratio for their DCP, 0 to limit the GUI to DCI
Flat/Scope



<Allow96kHzAudio> — 1 to allow users to make DCPs with 96kHz audio, 0 to always make 48kHz DCPs

<UseAllAudioChannels> — 1 to allow users to map audio to all 16 DCP channels, 0 to limit to the channels used
in standard DCPs

<ShowExperimentalAudioProcessors> — 1 to offer users the (experimental) audio upmixer processors, 0 to hide
them

<LogTypes> — Types of logging to write; a bitfield where 1 is general notes, 2 warnings, 4 errors, 8 debug information
related to 3D, 16 debug information related to encoding, 32 debug information for timing purposes, 64 debug
information related to sending email, 128 debug information related to the video view, 256 information about disk
writing, 512 debug information related to the player, 1024 debug information related to audio analyses.

<AnalyseEBUR128> — 1 to do EBUR128 analyses when analysing audio, otherwise 0.

<AutomaticAudioAnalysis> — 1 to run audio analysis automatically when audio content is added to the film,
otherwise 0.

<Win32Console> — 1 to open a console when running on Windows, otherwise 0. * We only write this if it’s true,
which is a bit of a hack to allow unit tests to work * more easily on Windows (without a platform-specific reference
in config_ write_ utf8_ test)

<Signer> — Certificate chain and private key to use when signing DCPs and KDMs. Should contain <Certificate>
tags in order and a <PrivateKey> tag all containing PEM-encoded certificates or private keys as appropriate.

<Decryption> — Certificate chain and private key to use when decrypting KDMs

<History> — Filename of DCP to present in the File menu of the GUI; there can be more than one of these tags.
<History> — Filename of DCP to present in the File menu of the player; there can be more than one of these tags.
<DKDMGroup> — A group of DKDMs, each with a Name attribute, containing other <DKDMGroup> or <DKDM> tags.
<DKDM> — A DKDM as XML

<CinemasFile> — Filename of cinemas list file.

<DKDMRecipientsFile> — Filename of DKDM recipients list file.

<ShowHintsBeforeMakeDCP> — 1 to show hints in the GUI before making a DCP, otherwise 0.
<ConfirmKDMEmail> — 1 to confirm before sending KDM emails in the GUI, otherwise 0.

<KDMFilenameFormat> — Format for KDM filenames.

<KDMFilenameFormat> — Format for DKDM filenames.

<KDMContainerNameFormat> — Format for KDM containers (directories or ZIP files).
<DCPMetadataFilenameFormat> — Format for DCP metadata filenames.

<DCPAssetFilenameFormat> — Format for DCP asset filenames.

<JumpToSelected> — 1 to make the GUI jump to the start of content when it is selected, otherwise 0.

<Nagged> — 1 if a particular nag screen has been shown and should not be shown again, otherwise 0.
<PreviewSound> — 1 to use sound in the GUI preview and player, otherwise 0.

<PreviewSoundOutput> (optional) — Name of the audio output to use.

<CoverSheet> — Text of the cover sheet to write when making DCPs.

<LastKDMWriteType> — Last type of KDM-write: flat for a flat file, folder for a folder or zip for a ZIP file.

<LastDKDMWriteType> — Last type of DKDM-write: file for a file, internal to add to DCP-o-matic’s list.



<FramesInMemoryMultiplier> — value to multiply the encoding threads count by to get the maximum number
of frames to be held in memory at once.

<DecodeReduction> — power of 2 to reduce DCP images by before decoding in the player.
<DefaultNotify> — 1 to default jobs to notify when complete, otherwise 0.

<Notification> — 1 if a notification type is enabled, otherwise 0.

<BarcoUsername> — Username for logging into Barco’s servers when downloading server certificates.
<BarcoPassword> — Password for logging into Barco’s servers when downloading server certificates.
<ChristieUsername> — Username for logging into Christie’s servers when downloading server certificates.
<ChristiePassword> — Password for logging into Christie’s servers when downloading server certificates.
<GDCUsername> — Username for logging into GDC’s servers when downloading server certificates.
<GDCPassword> — Password for logging into GDC’s servers when downloading server certificates.

<PlayerMode> — window for a single window, full for full-screen and dual for full screen playback with separate
(advanced) controls.

<ImageDisplay> — Screen number to put image on in dual-screen player mode.
<RespectKDMValidityPeriods> — 1 to refuse to use KDMs that are out of date, 0 to ignore KDM dates.
<PlayerLogFile> — Filename to use for player debug logs.

<PlayerContentDirectory> — Directory to use for player content in the dual-screen mode.
<PlayerPlaylistDirectory> — Directory to use for player playlists in the dual-screen mode.
<PlayerKDMDirectory> — Directory to use for player KDMs in the dual-screen mode.
<Al11owSMPTEBv20> — 1 to allow the user to choose SMPTE (Bv2.0 only) as a standard, otherwise 0

<ISDCFNamePartLength> — Maximum length of the "name" part of an ISDCF name, which should be 14 according
to the standard

<EnablePlayerHTTPServer> — 1 to enable a HTTP server to control the player, otherwise 0
<PlayerHTTPServerPort> — Port to use for player HTTP server (if enabled)

<RelativePaths> — 1 to write relative paths to project metadata files, 0 to use absolute paths
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